Wwise Unity

Wwise Unity  Unity  Unity  Wwise Sound Engine
""Integration Unity  C#  Wwise SDK API
Editor  Wwise SDK

Unity-Wwise  Wwise API  Wwise
C:\Program Files(x86)\Audiokinetic\Wwise [version] \Authoring\Help

- Unity
- Wwise
- Wwise Unity
- Unity
- Wwise Unity DLC
- API
- Wwise Demo Game
- Using Wwise Spatial Audio in Unity
Wwise Unity Integration

- Wwise Unity Integration 2017.2.1.6524.980
- Wwise Unity Integration 2017.2.0.6500.947
  - 2017.2
  - 2017.2
- Wwise Unity Integration 2017.1.4.6407.845
- Wwise Unity Integration 2017.1.3.6377.812
- Wwise Unity Integration 2017.1.2.6361.791
- Wwise Unity Integration 2017.1.1.6340.770
- Wwise Unity Integration 2017.1.0.6302.726
  - 2017.1
  - 2017.1
- Wwise Unity Integration 2016.2.4.6098.531
- Wwise Unity Integration 2016.2.3.6077.504
- Wwise Unity Integration 2016.2.2.6022.430
- Wwise Unity Integration 2016.2.1.5995.409
- Wwise Unity Integration 2016.2.1
- Wwise Unity Integration 2016.2.0
- Wwise Unity Integration 2016.1.3
- Wwise Unity Integration 2016.1.2
- Wwise Unity Integration 2016.2.1
- Wwise Unity Integration 2016.1
- Wwise Unity Integration 2015.1.4
- Wwise Unity Integration 2015.1.3
- Wwise Unity Integration 2016.1.2
- Wwise Unity Integration 2015.1.1
- Wwise Unity Integration 2016.1
- Wwise Unity Integration 2014.1.6
- Wwise Unity Integration 2014.1.5
- Wwise Unity Integration 2014.1.4
- Wwise Unity Integration 2014.1.3
- Wwise Unity Integration 2014.1.2
- Wwise Unity Integration 2014.1.1
- Wwise Unity Integration 2014.1
- Wwise Unity Integration 2013.2.9
- Wwise Unity Integration 2013.2.8
- Wwise Unity Integration 2013.2.5
- Wwise Unity Integration 2013.2.8
- Wwise Unity Integration 2013.1.1
- Wwise Unity Integration 2013.1
Wwise Unity Integration 2017.2.1.6524.980

Wwise 2017.2.1  Wwise SDK

- Wwise SDK 2017.2.1
- UnityUnity 5.5, 5.6, 2017.1, 2017.2, 2017.3 (Personal Pro)
  Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td>Unity 2017.3.0f3</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
<td>Unity 2017.3.0p3</td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Nintendo Switch 3.1.2 (Unity 5.6.4 with NintendoSDK 3.5.2)</td>
</tr>
</tbody>
</table>

- **WG-34267**: Placed the members of Wwise_IDS.cs within the AK namespace and prefixed class names with "Ak".
- **WG-35301**: Changed Event selector to automatically display in inspector when AkEventSection is added to Timeline track.
- **WG-35609**: Made AkRoomPortal inspector update the front and back rooms in real time.
- **WG-36086**: Added public functions to AkRoomPortal to update the front and back rooms.
- **WG-36099**: Fixed NullReferenceException when migrating from 2016.2.4.
- **WG-36125**: Fixed compatibility with Unity 5.5.
- **WG-36144**: Fully specified `System.IO.Path` in Wwise C# script to avoid potential conflicts.
- **WG-36219**: Fixed drag and drop from the Wwise Picker under Unity 2017.3.
- **WG-36356**: Exposed monitoring pool size and queue size in `AkInitializer` inspector.
- **WG-36413**: Fixed crash when having more than one portal from one room to the other.
Wwise Unity Integration 2017.2.0.6500.947

Wwise 2017.2.0  Wwise SDK  Unity 2017.3

- Wwise SDK: 2017.2.0
- UnityUnity 5.5, 5.6, 2017.1, 2017.2, 2017.3 (Personal Pro)
  Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac</td>
<td>Unity 2017.3.0f3</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
<td>Unity 2017.2.0f3</td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Nintendo Switch 3.1.2 (Unity 5.6.4 NintendoSDK 3.5.2)</td>
</tr>
</tbody>
</table>

- 2017.2

- 2017.2

- **WG-25994**: Made the audio input source plug-in accessible via C# scripting.  
  *Using the Audio Input Source Plug-in in Unity.*
- **WG-27337**: Added ability to post MIDI events to the sound engine.
Sending MIDI to Wwise.

- **WG-28541** Ak Ak
- **WG-33501**: Added automatic SoundBank management.
- **WG-34446**: Reduced memory allocations in `AkCallbackManager`. 
Wwise Unity Integration 201.1.4.6407.845

- Wwise SDK 2017.1.4
- Unity 5.5, 5.6, 2017.1, 2017.2 (Personal Pro).
  
  Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
<td>Unity 2017.2.0f3</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Nintendo Switch 3.1.2 (Unity 5.6.4 NintendoSDK 3.5.2)</td>
</tr>
</tbody>
</table>

- **WG-35168**: Fixed crash when loading SoundBanks on Switch.
- **WG-35383**: Fixed update of IDs associated with WwiseTypes when used as properties within custom inspectors.
- **WG-35384**: `AkAudioListener`, `AkInitializer`, and `AkTerminator` now implement `OnEnable()` instead of `Awake()`, so they are disabled when unchecked in the Editor.
- **WG-35513**: Added full custom positioning for `AkGameObj`.
- **WG-35958**: Unity 2017.3 support added. Note the integration has not been thoroughly tested in Unity 2017.3, but it should be compatible.
Wwise Unity Integration 2017.1.3.6377.812

Wwise 2017.1.3  Wwise SDK  Unity 2017.1

- Wwise SDK 2017.1.3
- Unity 5.5, 5.6, 2017.1  2017.2 (Personal  Pro).

<table>
<thead>
<tr>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
</tr>
<tr>
<td>iOS</td>
</tr>
<tr>
<td>Linux</td>
</tr>
<tr>
<td>Mac</td>
</tr>
<tr>
<td>PS4</td>
</tr>
<tr>
<td>PS Vita</td>
</tr>
<tr>
<td>tvOS</td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
</tr>
<tr>
<td>Windows</td>
</tr>
<tr>
<td>Xbox One</td>
</tr>
<tr>
<td>Switch</td>
</tr>
</tbody>
</table>

Unity 2017.2.0f3

Unity for Switch 1.0.1 (Unity 5.5.0p1 Nintendo SDK 1.4.0)

- **WG-34855**: Added AkSoundEngine.GetCurrentLanguage().
- **WG-35075**: Fixed: Added support for Unity 2017.2 integration in the Wwise Launcher.
### Wwise Unity Integration 2017.1.2.6361.791

Wwise 2017.2  Wwise SDK

- Wwise SDK: 2017.1.2
- Unity: Unity 2017.1Personal  Pro
  
  Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
<td>Unity 2017.1.1f1</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Switch 1.0.1 (Unity 5.5.0p1 Nintendo SDK 1.4.0)</td>
</tr>
</tbody>
</table>

Unity 2017.1.1f1
Wwise Unity Integration 2017.1.1.6340.770

Wwise 2017.1.1 Wwise SDK Unity 2017.1

- Wwise SDK: 2017.1.1
- Unity: Unity 2017.1

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac</td>
<td>Unity 2017.1.0f3</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td>Unity 5.6.1p1</td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Switch 1.0.1 (Unity 5.5.0p1 Nintendo SDK 1.4.0)</td>
</tr>
</tbody>
</table>

- **WG-33018**: Fixed: No localization folder is created when using the Decode Banks feature.
- **WG-33818**: Fixed bank decoding on iOS and Android.
- **WG-34090**: WSA Unity Plugin TLS Allocator Error spamming
- **WG-34205**: System.EventHandler
- **WG-34205**: UnityEngine.Menu UnityEngine.MenuItem
Wwise Unity Integration 2017.1.0.6302.726

Wwise 2017.1.0  Wwise SDK  Unity 2017.1

- Wwise SDK: 2017.1.0
- Unity: Unity 2017.1
  - Personal
  - Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac</td>
<td>Unity 2017.1.0f3</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>UWP (Universal Windows Platform)</td>
<td>Unity 5.6.1p1</td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Switch 1.0.1 (Unity 5.5.0p1 Nintendo SDK 1.4.0)</td>
</tr>
</tbody>
</table>

- 2017.1

- Wii U
- GameObject Unity Integration Extensions
- Wwise Installation and Migration Guide
- AkCallbackManager 2017.1
- **WG-27479**  AkInitializer
- **WG-30791**  WwiseTypes  WwiseTypes
- **WG-31155**  AkMemSettings  AkChannelConfig  SoundEngine
- **WG-31735**  GameObjects  Unity Integration  Extensions
- **WG-32348**  SoundBanksInfo  XML
- **WG-32657**  foreach
- **WG-33303**  AK_MusicPlaylistSelect
- **WG-34003**
Wwise Unity Integration 2016.2.4.6098.531

Wwise 2016.2.4 Wwise SDK

• Wwise SDK: 2016.2.4
• Unity: Unity 5.6Personal Pro
  Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td>Unity 5.6.1p1</td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store (Universal Windows Platform)</td>
<td>Unity 5.6.1p1</td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Switch 1.0.1 (Unity 5.5.0p1 NintendoSDK 1.4.0)</td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.4.2f2</td>
</tr>
</tbody>
</table>

• WG-33395
Wwise Unity Integration 2016.2.3.6077.504

Wwise 2016.2.3  Wwise SDK

- Wwise SDK: 2016.2.3
- Unity: Unity 5.6Personal Pro
  Unity 4

<table>
<thead>
<tr>
<th></th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store (Universal Windows Platform)</td>
<td>Unity 5.6.0f3</td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td>Unity for Switch 0.6.1</td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.4.2f2</td>
</tr>
</tbody>
</table>

- WG-32536 Nintendo Switch
- WG-32623 Android
Wwise Unity Integration 2016.2.2.6022.430

Wwise 2016.2.2  Wwise SDK

- Wwise SDK: 2016.2.2
- Unity: Unity 5.5Personal  Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td>Unity 5.5.0p4</td>
</tr>
<tr>
<td>Windows Store (Universal Windows Platform)</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.4.2f2</td>
</tr>
</tbody>
</table>

- WG-31862

...
**Wwise Unity Integration 2016.2.1.5995.409**

2016.2.1 Wwise SDK

- Wwise SDK: 2016.2.1
- Unity: Unity 5.5Personal Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td>Unity 5.5.0f3</td>
</tr>
<tr>
<td>Windows Store (Universal Windows Platform)</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.4.2f2</td>
</tr>
</tbody>
</table>

- WG-32006 GameObject "Unknown Game Object ID"
**Wwise Unity Integration 2016.2.1**

2016.2.1  Wwise SDK

- Wwise SDK: 2016.2.1
- Unity: Unity 5.5Personal  Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td>Unity 5.5.0f3</td>
</tr>
<tr>
<td>Windows Store (Universal Windows Platform)</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.4.2f2</td>
</tr>
</tbody>
</table>

- WG-27085 AuxSends
- WG-31127 AK_MusicSyncUserCue
- WG-31650 **AkGameObj**  NullReferenceException
- WG-31651 SetObjectPosition  AkGameObj
- WG-31862

- **Unity case #861189** Unity Windows Store  Launcher
Wwise Unity Integration 2016.2.0

Wwise 2016.2.0  Wwise SDK

- Wwise SDK: 2016.2.0
- Unity: Unity 5.4Personal  Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store (Universal Windows Platform)</td>
<td>Unity 5.4.1p2</td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td></td>
</tr>
<tr>
<td>Windows Phone 8.1</td>
<td></td>
</tr>
<tr>
<td>Windows Store 8.0  8.1</td>
<td></td>
</tr>
<tr>
<td>Windows Store 8.1 Windows Store</td>
<td></td>
</tr>
<tr>
<td>Universal Windows Platform (UWP)</td>
<td></td>
</tr>
<tr>
<td>Xbox 360</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td></td>
</tr>
</tbody>
</table>

- WG-30571 Library Wwise Unity
- WG-30960  AkGameObj  Unity
- WG-31507 MediaID  bStreaming  duration
## Wwise Unity Integration 2016.1.3

Wwise 2016.1.3  Wwise SDK

- Wwise SDK: 2016.1.3
- Unity: Unity 5.4Personal Pro

<table>
<thead>
<tr>
<th></th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.4.0p2</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.2.4f1</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>
Wwise Unity Integration 2016.1.2

Wwise 2016.1.2  Wwise SDK  Wwise Unity

- Wwise SDK: 2016.1.2
- Unity: Unity 5.4Personal  Pro
  - Unity 4

<table>
<thead>
<tr>
<th></th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.4.0p2</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.2.4f1</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- WG-30567  WAV

- SWIG   ZIP  SWIG  SWIG
- Wwise 2014.1.4  2016.1  2015.1.6  2016.1
- Unity  Unity 5.4  Wwise  2016.1.2  Unity 5.4
  - Wwise 2016.1.2
Wwise Unity Integration 2016.1.1

Wwise 2016.1.1  Wwise SDK

- Wwise SDK: 2016.1.1
- Unity: Unity 5.3Personal  Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.3.5p6</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>tvOS</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.2.4f1</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- WG-30021 SoundBank
- WG-30228 Linux
- WG-30231 tvOS
- WG-30259 GC.Collect  AkGameObj

- WG-30128 Vita  SoundBank
• WG-30139Vita
# Wwise Unity Integration 2016.1

Wwise 2016.1  Wwise SDK

- Wwise SDK: 2016.1
- Unity: Unity 5.3Personal  Pro
  - Unity 4

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.3.4p3</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 5.2.4f1</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- WG-25675  Wwise Picker  “Generate SoundBanks”  Wwise  SoundBank
- WG-27583  Unity assets  SoundBank  Unity SoundBank
- WG-28175  WwiseGlobal
- WG-26011  Ak Audio Listener  Default Unity Audio Listener
- SWIG ZIP SWIG SWIG
- Wwise 2014.1.4 2016.1 2015.1.6 2016.1

- WG-30021 Editor DecodeBanks
- WG-30021 DecodeBanks SoundBank DecodedBanks

- WG-30128 Vita SoundBank
- WG-30128 WiiU SoundBank
Wwise Unity Integration 2015.1.4

2015.1.4 Wwise SDK

- Wwise SDK: 2015.1.4
- Unity Unity 4.6 Pro Unity 5.2 (Personal Pro)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>Metro</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.2.2p1</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Phone</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 4.3.7f1 Wii U add-on 2.2.5</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- WG-28412 AkGameObj
- WG-28723 PS4
Wwise Unity Integration 2015.1.3

Wwise 2015.1.3 Universal Windows Platform  Wwise SDK

- Wwise SDK: 2015.1.3
- Unity 4.6 Pro  Unity 5.2 (Personal  Pro)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td>Unity 5.2.2p1</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Store Apps</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 4.3.7f1  Wii U add-on 2.2.5</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- Windows Store Apps  Universal Windows Platform
- Windows Store Apps SDK 8.1
- Windows Phone 8.0
- Windows Store Apps SDK 8.0

- WG-25945 Wwise  Unity  WwiseGlobal  Unity /
  Wwise
- WG-26011  Ak Audio Listener  Default Unity Audio
  Listener
- WG-28108
- WG-28175 WwiseGlobal
• WG-28479  Main Camera
• WG-28526  Unity Editor  GameObjects
  SoundEngine
## Wwise Unity Integration 2015.1.2

Wwise 2015.1.2  Wwise SDK

- Wwise SDK: 2015.1.2
- Unity 4.6.5 Pro  Unity 5.1.2p2 (Personal  Pro)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td>Unity 5.2.0f3</td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>Metro</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Phone</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 4.3.7f1  Wii U add-on 2.2.5</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- WG-27029  Unity GameObject  \textbf{AkGameObject}

- WG-28200  Everything  \((0, 0, 0)\) GameObjects  3D mask  L0
Wwise Unity Integration 2015.1.1

Wwise 2015.1.1  Wwise SDK

- Wwise SDK: 2015.1.1
- UnityUnity 4.6.5 Pro  Unity 5.1.2p2 (Personal  Pro)

<table>
<thead>
<tr>
<th></th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>Metro</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.1.2p2</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PS Vita</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Phone</td>
<td></td>
</tr>
<tr>
<td>Xbox One</td>
<td></td>
</tr>
<tr>
<td>Wii U</td>
<td>Unity 4.3.7f1  Wii U add-on 2.2.5</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
</tbody>
</table>

- WG-27977  Unity
- WG-28030 Wii U/Unity TRC
- WG-28042 Unity Wwise
- WG-28044 UnityWwise
- WG-28046  AkInitializer
- WG-28048 Wwise GameObject
Wwise Unity Integration 2015.1

Wwise 2015.1  Wwise SDK

- Wwise SDK: 2015.1

- WG-25669 Wwise Picker  Auto Populate  Mac Editor

- WG-27079 WwiseSettings.xml
## Wwise Unity Integration 2014.1.6

**2014.1.6 Wwise SDK**

- Wwise SDK: 2014.1.6
- UnityUnity 4.6.5 Pro, Unity 5.0.2 (Personal Pro)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>Metro</td>
<td>Unity 5.0.2p3</td>
</tr>
<tr>
<td>PS3</td>
<td></td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PSVita</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Phone</td>
<td></td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
<tr>
<td>Xbox One</td>
<td>Unity 5.0.2p4</td>
</tr>
</tbody>
</table>

- WG-27585  Wwise Picker    Wwise
- WG-27624 (PS3) SetListenerPosition PS3

### Unity

- Xbox OneSoundEngine Unity
- Windows Store Apps in Unity 4 DllNotFoundException

- WG-27585  Wwise Picker    Wwise
Wwise Unity Integration 2014.1.5

Wwise 2014.1.5  Wwise SDK

- Wwise SDK: 2014.1.5
- UnityUnity 4.6.5 Pro, Unity 5.0.2 (Personal Pro)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Wwise Unity Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td></td>
</tr>
<tr>
<td>iOS</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
</tr>
<tr>
<td>Metro</td>
<td></td>
</tr>
<tr>
<td>PS3</td>
<td>Unity 5.0.2p3</td>
</tr>
<tr>
<td>PS4</td>
<td></td>
</tr>
<tr>
<td>PSVita</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Windows Phone</td>
<td></td>
</tr>
<tr>
<td>Xbox 360</td>
<td>Unity 5.0.1f1</td>
</tr>
<tr>
<td>Xbox One</td>
<td>Unity 5.0.2p4</td>
</tr>
</tbody>
</table>

- WG-25669Wwise Picker  Auto Populate  Mac Editor

Unity

- Xbox OneSoundEngine  Unity
- Windows Store Apps in Unity 4  DllNotFoundException

- Android x86
- Windows Store Apps  Scripting Define Symbols
• WG-27108 Destroy Unity
• WG-25733 Windows iOS/Mac
• WG-26875 AkMemBankLoader
Wwise Unity Integration 2014.1.4

Wwise 2014.1.4  Wwise SDK  Unity 5

- Wwise SDK: 2014.1.4
- Unity 4 Pro  Unity 5 Personal  Pro

- WG-26780  Wwise Unity
- WG-26837  AkBankManager  SoundBank

- WG-25669  Wwise Picker  Auto Populate  Mac Editor
- WG-25733  Windows  iOS/Mac

- Windows Phone 8.1  Metro
- Unity 5  Wwise Unity Integration  Plugin Importer API
  <UNITY_PROJECT_ROOT>/Assets/Plugins

Unity 4  Unity 5

1.
2.  Unity 5  Unity 4  Unity
3.  Unity 5  2014.1.4  Unity
4.  ""
5.
6.  Unity 5  Wwise Unity Integration
Wwise Unity Integration 2014.1.3

Wwise 2014.1.3  Wwise SDK

- Wwise SDK: 2014.1.3

- WG-25669 Wwise Picker  Auto Populate  Mac Editor
- WG-25733 Windows  iOS/Mac
Wwise Unity Integration 2014.1.2

Wwise 2014.1.2 Wwise SDK

- Wwise SDK: 2014.1.2
- XDK Unity Editor10 XDK Wwise SDK11 XDK Xbox One

- WG-26305 null GameObject 64 GameObject
- WG-26337 Mac 64
- WG-26385 Wwise Android Unity CPU
- WG-26395 MSBUILD Windows Phone 8
- WG-26430 iOS SetBasePath()

- WG-25669 Wwise Picker Auto Populate Mac Editor
- WG-25733 Windows iOS/Mac
Wwise Unity Integration 2014.1.1

Wwise 2014.1.1  Wwise SDK

- Wwise SDK: 2014.1.1
- Unity: 4.x 5.0

- Wii U
- Plug-in Registration
- Unity "Wwise Settings"  Wwise Sound Engine
- GeneratedSoundBanks  Populate

- WG-26201  C# System
  - WG-25669  Wwise Picker  Auto Populate  Mac Editor
  - WG-25733  Windows  iOS/Mac

- WG-25669  Wwise Picker  Auto Populate  Mac Editor
- WG-25733  Windows  iOS/Mac
Wwise Unity Integration 2014.1

Wwise 2014.1  Wwise SDK  Demonstration
Wwise Unity Integration 2013.2

- Wwise Unity Integration 2013.2

- Wwise SDK: 2014.1
- Unity: 4.x

- Android
- iOS
- Linux
  - 32
  - 64
- Mac OS X10.6
- PS3
- PS4
- PS Vita
- Windows
  - 32
  - 64
- Windows 8Metro
  - Desktop
  - Intel  Windows Store App ARM
- Windows Phone 8.0
- Xbox360
- Xbox One
- pg_wwisedemoscene
- Wwise Unity Integration 2013.2
- Wwise Components Wwise Unity Integration UUID
  Wwise Project Unity
- Wwise Events Trigger
- Wwise inspector AkAmbient
- AkSoundEngine
- WwiseGlobal AkListener

- WG-25783 Callback Manager
- WG-25677 Mac

- WG-25669 Wwise Picker Auto Populate Mac Editor
- WG-25733 Windows iOS/Mac
Wwise Unity Integration 2013.2.9

Wwise 2013.2.9  Wwise SDK

- Wwise SDK: 2013.2.9
- Unity: 4.x

- Android
- iOS
- Linux
  - 32
  - 64=
- Mac OS X10.6
- PS3
- PS4
- PS Vita
- Windows
  - 32
  - 64
- Windows 8Metro
  - Desktop
  - Intel  Windows Store App ARM
- Windows Phone 8.0
- Xbox360
- Xbox One

- Windows Phone 8.0
Wwise Unity Integration 2013.2.8

Wwise 2013.2.8  Wwise SDK  Wwise-Unity

- **Unity**
- Wwise Picker  Wwise  **Wwise Picker**
- Unity  **Wwise Unity**
- Wwise-Unity Integration  Wwise SDK

- Wwise SDK: 2013.2.8
- Unity: 4.x

- Android
- iOS
- Linux*
  - 32
  - 64
- Mac OS X10.6
- PS3
- PS4
- PS Vita
- Windows
  - 32
  - 64
- Windows 8Metro
  - Desktop
  - Intel  Windows Store App ARM
- Windows Phone 8.0
- Xbox360
- Xbox One
• Xbox One
• PS4
• Linux * Unity Integration for Linux is supported in Wwise 2013.2.8 Linux BETA.
• Windows Phone 8.0

• Multi-architecture Windows Metro Unity Scripting Define Symbol
• Unity Editor Integration
• Integration
• Windows IDE Visual Studio 2008 2010
• Windows Metro
Wwise Unity Integration 2013.2.5

Wwise 2013.2.5  Wwise SDK

- Wwise SDK: 2013.2, 2013.2.x
- Unity: 4.x

- Android
- iOS
- Mac OS X10.6
- PS3
- PS4
- PS Vita
- Windows
  - 32
  - 64
- Windows 8Metro
  - Desktop
  - Intel  Windows Store App ARM
- Xbox 360
- Xbox One

- PS4
- PS Vita
- Xbox One
- Android API AddBasePath()  I/O  POSIX

- WG-24351iOS
Wwise Unity Integration 2013.2.4

Wwise 2013.2.4  Wwise SDK

- Wwise SDK: 2013.2, 2013.2.x
- Unity: 4.x

- Windows 8Metro
  - Desktop
  - Intel  Windows Store App ARM
- Windows
  - 32
  - 64
- Mac OS X10.6
- iOS
- Android
- Xbox360
- PS3

- Wwise > Help  Integration
- Version.txt  Wwse SDK

- WG-24080 Windows  Mac API  Android

- Android armeabi
Wwise Unity Integration 2013.2.1

2013.2.1 Wwise SDK overhauled distribution

- Wwise SDK: 2013.2, 2013.2.1
- Unity4.x 3.x

- Windows 8Metro
  - Desktop
  - Intel Windows Store App ARM
- Windows
  - 32
  - 64
- Mac OS X10.6
- iOS
- Android
- Xbox360
- PS3

- Unity Integration  Unity  Unity  Editor
- Unity Editor UI  Wwise
  - Integration
    - SoundBank ID C++ header  C#
- Unity 4  Scripting Define Symbols  Windows
- Integration
- IntegrationDemo
- AndroidSoundBank  Android Expansion FilesOBB

- WG-23781
• WG-23734 Windows
• WG-23345 Unity Editor
• WG-23436 Unity
• WG-23423 Unity GameObjects
• WG-22533 Unity API

• iOS

• **Unity**
  • BUILD THE APPLICATION FOR A MULTI-ARCHITECTURE PLATFORM
• iOS Xcode API
• UI
• Apple
• SWIG 2.0.11 Mac pg_compileswig SWIG
Wwise Unity Integration 2013.1.1

Wwise 2013.1.1  Wwise SDK Integration
Wwise Unity Integration 2013.1

Wwise 2013.1  Wwise SDK Android

- Wwise SDK: 2012.2.x, 2013.1
- Unity: 3.4.x, 3.5.x, 4.x

- Windows 8
  - Desktop
  - Intel Windows Store App ARM
- Windows32
- Windows64
- Mac OS X10.6
- iOS
- Android
- Xbox360
- PS3

- AndroidSoundBank  Android apk LoadBank() API

- Windows 64
- Windows 8

- WG-22948 PS3
- WG-22938 Mac OSX Unity Integration
- WG-22334Music userCue  Unity
- WG-22329Unity Integration  PostEvent()
- WG-22255Unity Android
- WG-221653D  iOS  Android
- WG-21933AkCallbackManager.cs UserCue
- WG-21365 Unity iOS/iOS
- WG-22533 API

- Windows
- Mac
- Unity

- Python
- Integration Unity

- Visual Studio 2010
- PS3
- Integration
- Python 2.6
- Python 2.7.x
- 3.x
- Integration
- UNITY_PROJECT_ROOT
- Integration
- UNITY_PROJECT_ROOT
- Android
- PostprocessBuildPlayer
- Unity
- IntegrationDemo
- Unity 4

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
2017.2

Wwise 2017.1  Unity

- **Edit Mode Support**
  - Loading and Unloading Banks in Edit Mode
- **Additions to WwiseGlobal Game Object**
- **Wwise Audio Input Plug-in**
- **MIDI Events**
- **Automatic SoundBank Management**
**Edit Mode Support**

The Wwise sound engine is now initialized while Unity is in Edit mode. This means Wwise Events can be triggered from the editor without entering Play mode. In order to demonstrate this, the inspectors for **AkEvent** (and **AkAmbient**) have been updated. There are now buttons in the inspector that can be used to play and stop the Events directly from the editor. The Play/Stop button plays and stops individual Events. When multiple objects that have AkEvents are selected, the Play Multiple and Stop Multiple buttons play or stop all currently selected Events. The Stop All button stops all currently playing Events.

![Ak Ambient (Script)](image)

**Loading and Unloading Banks in Edit Mode**

Note that in order for the edit mode functionality to work correctly, the corresponding **AkBank** components should have their Load On: property set to Awake and their Unload On: property set to Never.
Additions to WwiseGlobal Game Object

The WwiseGlobal game object now has an AkEditorEventPlayer component. This component is editor only, and is used to play WwiseEvents that are associated to AkEvent components in Edit mode. The WwiseGlobal object also now has Rigidbody, AkGameObj, and AkAudioListener components. These are used for interactions between AkEnvironment, AkGameObj, and AkRoom components in Edit mode.

Unity
Wwise Audio Input Plug-in

The Wwise Audio Input Source Plug-in is now accessible via C# scripting.

Using the Audio Input Source Plug-in in Unity.
MIDI Events

MIDI events can now be posted to Wwise via C# scripting. Sending MIDI to Wwise.
Automatic SoundBank Management

Automatic SoundBank management has been added.
Spatial Audio Integration

Added spatial audio API to the Unity integration. See Using Wwise Spatial Audio in Unity for a tutorial.
<table>
<thead>
<tr>
<th>2017.2</th>
<th>2017.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>ErrorLevel</td>
<td>AK.Monitor.ErrorLevel</td>
</tr>
<tr>
<td>DynamicSequenceType</td>
<td>AK.SoundEngine.DynamicSequence.DynamicSequenceType</td>
</tr>
<tr>
<td>MultiPositionType</td>
<td>AK.SoundEngine.MultiPositionType</td>
</tr>
<tr>
<td>PreparationType</td>
<td>AK.SoundEngine.PreparationType</td>
</tr>
<tr>
<td>RTPCValue_type</td>
<td>AK.SoundEngine.Query.RTPCValue_type</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2017.2</th>
<th>2017.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Iterator</td>
<td>AkIterator</td>
</tr>
<tr>
<td>Playlist</td>
<td>AkPlaylist</td>
</tr>
<tr>
<td>PlaylistItem</td>
<td>AkPlaylistItem</td>
</tr>
</tbody>
</table>
Wwise Unity »
2017.1

Wwise 2017.1  Unity

- WwiseTypes
- Unity Integration Extensions
- 3D
AkEvent

AkEnvironment  AkEnvironmentPortal  Rigidbody  Rigidbody

AkEnvironment  AkEnvironmentPortal  Rigidbody

AkGameObj  "Environment aware"  Rigidbody  Editor

AkGameObj-AkEnvironment interactions require a Rigidbody component on the object or the environment.

Wwise Settings  Show Warning for Missing Rigidbody

Wwise v20.1 Build Settings.

Wwise Project

Wwise Project Path*: \WwiseProject\WwiseProject.wproj

Wwise Windows Installation Path

Wwise Windows Installation Path: C:\dev\wise_main

Asset Management

SoundBanks Path* (relative to StreamingAssets folder): Audio\GeneratedSoundBanks

Create WwiseGlobal GameObject

Automatically add listener to Main Camera

In Editor Warnings

Show Warning for Missing Rigidbody

* Mandatory settings
public class Footsteps : MonoBehaviour
{
    [Header("Wwise Types")]
    public AK.Wwise.Event FootStepEvent = null;
    public AK.Wwise.RTPC SpeedRTPC = null;
    public AK.Wwise.Switch UnderFootMaterialSwitch = null;
    public AK.Wwise.Bank FootStepBank = null;

    void InitializeSound() { FootStepBank.Load(); }
    void FinalizeSound() { FootStepBank.Unload(); }

    void PlayFootStepSound(float speed)
    {
        SpeedRTPC.SetValue(gameObject, speed);
        UnderFootMaterialSwitch.SetValue(gameObject);
        FootStepEvent.Post(gameObject);
    }
}
Unity Integration Extensions

AkSoundEngine          Launcher
3D

Wwise 3D

AkGameObj       AkAudioListener

AkGameObj       AkAudioListener

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
2017.1

AkCallbackManager

- AkCallbackManager.AudioInterruptionCallback()
  ```csharp
  public delegate AKRESULT AudioInterruptionCallback(bool in_bEnterInterruption, object in_Cookie);
  ```

- AkCallbackManager.BGMCallback() :
  ```csharp
  public delegate AKRESULT BGMCallback(bool in_bOtherAudioPlaying, object in_Cookie);
  ```

- AkCallbackManager.EventCallback() :
  ```csharp
  public delegate void EventCallback(object in_cookie, AkCallbackType in_type, AkCallbackInfo in_info);
  ```

- `AkCallbackManager AkCallbackInfo C++
- `gameObjID ulong IntPtr
- `AkCallbackManager.AkMidiEventCallbackInfo
  AkMIDIEventCallbackInfo "MIDI"
- `AkCallbackManager.AkMusicSyncCallbackInfoBase
  AkMusicSyncCallbackInfo
- `AkCallbackManager.AkMusicSyncCallbackInfo.segmentInfo
  AkMusicSyncCallbackInfo.segmentInfo_*

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>Platform</th>
<th>Dependency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unity</td>
<td>Unity 5.5 (Personal  Pro)</td>
</tr>
<tr>
<td>iOS</td>
<td>Xcode 7.2 iOS SDK</td>
</tr>
<tr>
<td>Linux</td>
<td>libSDL2 (Linux)</td>
</tr>
<tr>
<td>Windows</td>
<td>DirectX End-User runtime x64 Visual Studio 2013 redistributable</td>
</tr>
<tr>
<td>Windows 32- Debug</td>
<td>x86 Visual Studio 2013 redistributable</td>
</tr>
</tbody>
</table>
Wwise

Wwise Launcher

- Unity Launcher
- Wwise Unity
- Unity check out Unity
Unity Integration Extensions

partial Launcher
Unity

- Edit > Project Settings > Audio   Disable Audio
- "Create WwiseGlobal GameObject"   "Wwise Global"
  AkInitializer   AkTerminator   WwiseThe WwiseGlobal object is also given AkEditorEventPlayer, AkAudioListener and AkGameObj scripts which are used for previewing AkEvent objects in edit mode. A Rigidbody component is added such that interactions between AkEnvironment, AkRoom and AkGameObj can also be previewed.
- Script Execution Order Wwise   AkInitializer AkGameObj
  AkAudioListener AkBank   AkTerminator   "Add Ak Listener to Main Camera"   Unity   Audio Listener   Main Camera
  AkAudioListener.cs   Main Camera
- Play in Background   Wwise Profiler

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Wwise  Wwise  SoundBank Wwise

1. WAV Windows Explorer WAV Project Explorer Audio
2. Sound New Event
3. SoundBank SoundBanks F7 New
4. SoundBank Event Project Explorer SoundBank
5. Generate SoundBanks

Unity

1. Wwise Picker Window > Wwise Picker Events SoundBanks
2. SoundBank
3. Event
4.
Unity Wwise Unity

- AkAmbient
- AkBank SoundBank
- AkEnvironment

Wwise API

- Integrate Wwise Elements into Your Game
- AK::SoundEngine Namespace Reference

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
To avoid packaging the SoundBanks for all platforms with your game, you should enable the automatic generation of SoundBanks or use a `BuildPlayerPipeline` script.
Wwise Unity SoundBank

- Wwise
- SoundBank
- Unity
- SoundBank StreamingAssets

Unity

- Wwise Compressor
- Wwise Delay
- Wwise Expander
- Wwise Gain
- Wwise Matrix Reverb
- Wwise Meter
- Wwise Parametric EQ
- Wwise Peak Limiter
- Wwise RoomVerb
- Wwise Silence
- Wwise Sine
- Wwise Tone Generator

Wwise Unity

Wwise McDSPiZotopeAuroSoundSeedCrankcase REV Convolution ReverbMotion Wwise

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
/ Wwise

- Unity  Unity
- Unity  check-out  Unity
- Wwise  Unity
- C++  AkSoundEngine  C++  Wwise  SDK  C++

Wwise  Unity  Wwise  Unity  Wwise
Wwise  Launcher  Wwise

Wwise  Wwise

2  Wwise  Unity
Wwise

1. Wwise Wwise Unity Wwise
   - Wwise

1. Wwise “Yes”
2. Unity Wwise SoundBank
**Wwise Unity**

- **AkAmbient** Use this component to attach a Wwise Event to any object in a scene. The sound can be started at various moments, dependent on the selected Unity trigger. This component is more useful for ambient sounds (sounds related to scene-bound objects) but could also be used for other purposes. Since **AkAmbient** has **AkEvent** as its base class, it features the play/stop, play multiple, stop multiple and stop all buttons for previewing the associated Wwise event.

- **AkAudioListener**
  Add this script on the game object that represent a listener. This is normally added to the Camera object or the Player object, but can be added to any game object when implementing 3D busses. **isDefaultListener** determines whether the game object will be considered a default listener - a listener that automatically listens to all game objects that do not have listeners attached to their **AkGameObjListenerList**'s.

- **AkBank**
  Loads and unloads a SoundBank at a specified moment. Vorbis sounds can be decompressed at a specified moment using the decode compressed data option. In that case, the SoundBank will be prepared.

- **AkEmitterObstructionOcclusion**
  Obstructs/Occludes the emitter of the current game object from its listeners if at least one object is between them.

- **AkEnvironment**
  Use this component to define a reverb zone. This needs to be added to a collider object to work properly.

- **AkEnvironmentPortal**
  Use this component to define an area that straddles two different AkEnvironments zones and allow mixing between both zones.

- **AkEvent**
  Wwise Unity
- **AkGameObj**
  This component represents a sound object in your scene tracking its position and other game syncs such as Switches, RTPC and environment values. You can add this to any object that will emit sound, and it will be added to any object that an **AkAudioListener** is attached to. Note that if it is not present, Wwise will add it automatically, with the default values, to any Unity Game Object that is passed to Wwise.

- **AkRoom**
  An **AkRoom** is an enclosed environment that can only communicate to the outside/others rooms with AkRoomPortals.

- **AkRoomPortal**
  Loads and unloads a SoundBank at a specified moment. Vorbis sounds can be decompressed at a specified moment using the decode compressed data option. In that case, the SoundBank will be prepared.

- **AkEmitterObstructionOcclusion**
  Obstructs/Occludes the spatial audio portal of the current game object from the spatial audio listener if at least one object is between them.

- **AkSpatialAudioEmitter**
  Add this script on the GameObject which represents an emitter that uses the Spatial Audio API.

- **AkSpatialAudioListener**
  Add this script on the game object that represent a listener. This is normally added to the Camera object or the Player object, but can be added to any game object when implementing 3D busses. **isDefaultListener** determines whether the game object will be considered a default listener - a listener that automatically listens to all game objects that do not have listeners attached to their AkGameObjListenerList's.

- **AkState**
  This will call **AkSoundEngine.SetState()** whenever the selected Unity event is triggered. For example this component could be set on a Unity collider to trigger when an object enters it.

- **AkSurfaceReflector**
  This component will convert the triangles of the GameObject's geometry into sound reflective surfaces.

- **AkSwitch**
This will call `AkSoundEngine.SetSwitch()` whenever the selected Unity event is triggered. For example this component could be set on a Unity collider to trigger when an object enters it.

: **Wwise Picker**

- **AK.Wwise.AuxBus**
  This type represents an auxiliary send in the Master-Mixer Hierarchy.
- **AK.Wwise.Bank**
  This type can be used to load/unload SoundBanks.
- **AK.Wwise.CallbackFlags**
  This type represents the values of the flags used when posting an Event with a callback.
- **AK.Wwise.Event**
  This type can be used to post Events to the sound engine.
- **AK.Wwise.RTPC**
  This type can be used to set game parameter values to the sound engine.
- **AK.Wwise.State**
  This type can be used to set Wwise States.
- **AK.Wwise.Switch**
  This type can be used to set **Switch** values on gameobjects.
- **AK.Wwise.Trigger**
  This type can be used to post triggers to the sound engine.

: **Wwise Types**
Wwise

- **Wwise Picker**: Event Wwise Picker Unity Viewer Inspector Game Object
- **Add Component**: AkAmbient AkEvent Unity Game Object
- **Wwise Types C#**: AK.Wwise.Event.Post()
- **C#**: AkSoundEngine.PostEvent()
inspector AkAmbient

- **AkAmbient:**
  - **Trigger On**
    - Unity Unity Wwise
    - AkSoundEngine.PostEvent
  - **Event Name:**
    - Wwise
  - **Action On Event**
    - Unity Wwise
      - **Action On Event Type**
      - **Curve Interpolation:**
      - **Fade Time:**
  - **Use Callback:**
    - **Game Object**
    - **Callback Function:**
      - `Game Object`  `Callback Function`
      - `void FunctionName(AkEventCallbackMsg in_info)`
    - **Callback Flags:**
      - `AkCallbackType`
  - **Play / Stop:**
    - Can be used to preview the Wwise Event when in Edit mode.
  - **Stop All:**
    - Stops all currently playing Wwise events.
  - **Position Type**
    - **Simple Mode**
- **Large_Mode**
  Add

- **MultiPosition_Mode**

  AkAmbient

  AkAmbient

  AkAmbient

  Unity

  AkAmbient

  AkAmbient

  On

  **Show Attenuation Sphere:**

  **Wwise SoundBank**

  Max

  **Attenuation**

  Project->Project Settings->Soundbanks->Max attenuation

- **Dont_Show**

- **Current_Event_Only**

  AkSoundEngine.PostEvent

  **Simple_Mode**

  **Large_Mode**

  **MultiPosition_Mode**

  **MultiPosition_Mode**

  **AkAmbient**

- **All_Events**

  AkAmbient
Using Wwise with Unity Timeline

For Unity's Timeline feature, there are custom Wwise tracks for triggering Wwise events and setting Wwise RTPC values.

:  

Wwise Timeline Integration
inspector AkEnvironment
AkEnvironmentPortal

Wwise Reverb Zone Environment Auxiliary Sends
Reverb Zone Wwise

AkEnvironment AkEnvironment AkEnvironment

- Wwise Picker AkEnvironment AuxBus Wwise
  Picker Unity Viewer Inspector Game Object
  AkEnvironment
- "Add Component" AkEnvironment Unity Game
  Object Inspector
- C# AkSoundEngine.SetGameObjectAuxSendValues()

portal

Unity GameObject->Wwise->Environment Portal

environment aware AkGameObj
AkEnvironmentPortal AkEnvironment inspector

Wwise 4 4

- 4
- 4
  - 4 Default Exclude Others
  - Default
  - Exclude Others

- AkEnvironment
  4
  - Priority:

  4 4
- Default

- Exclude Others

  Exclude Others

  Exclude Others

- AuxBus Name

  AuxBus  AuxBus  AuxBus  AuxBus  AuxBus
  AuxBus  Ok  AuxBus  Wwise Picker  AuxBus
  AuxBus

- AkEnvironmentPortal

  Unity  GameObject->Wwise->Environment Portal

- Environment #1

- Environment #2

- Axis

  z  x  z

  :  

  - AK::SoundEngine::SetGameObjectAuxSendValues
Sending MIDI to Wwise.

MIDI can be sent to Wwise by filling the `AkMIDIPost` members of `AkMIDIPostArray` class and calling any of the following methods:

- `AkMIDIPostArray.PostOnEvent()`
- `AkSoundEngine.PostMIDIOnEvent()`
- `AK.Wwise.Event.PostMIDI()`

The following is a basic script that sends MIDI messages to the sound engine:

```csharp
public class MyMIDIBehaviour : UnityEngine.MonoBehaviour
{
    public AK.Wwise.Event SynthEvent;

    private void Start()
    {
        AkMIDIPostArray MIDIPostArrayBuffer = new AkMIDIPostArray(6);
        AkMIDIPost midiEvent = new AkMIDIPost();
        midiEvent.byType = AkMIDIEventType.NOTE_ON;
        midiEvent.byNote = 60;
        midiEvent.byVelocity = 100;
    }
}
```
Using the Audio Input Source Plug-in in Unity.

The audio input source plug-in can be used via C# scripting. See Audio Input Source Plug-in from the Wwise SDK documentation.

The following is a basic script that sends a test tone to the audio input source plug-in:
public class MyAudioInputBehaviour : UnityEngineMonoBehaviour
{
    public AK.Wwise.Event AudioInputEvent;
    public uint SampleRate = 48000;
    public uint NumberOfChannels = 1;
    public uint SampleIndex = 0;
    public uint Frequency = 880;
    private bool IsPlaying = true;

    // Callback that fills audio samples - This function is called each frame for every channel.
    bool AudioSamplesDelegate(uint playingID, uint channelIndex, float[] samples)
    {
        for (uint i = 0; i < samples.Length; ++i)
            samples[i] = UnityEngine.Mathf.Sin(Frequency * 2 * UnityEngine.Mathf.PI * (i + SampleIndex) / SampleRate);

        if (channelIndex == NumberOfChannels - 1)
            SampleIndex = (uint)(SampleIndex + samples.Length) % SampleRate;

        // Return false to indicate that there is no more data to provide. This will also stop the associated event.
        return IsPlaying;
    }

    // Callback that sets the audio format - This function is called once before samples are requested.
    void AudioFormatDelegate(uint playingID, AkAudioFormat audioFormat)
    {
        // Channel configuration and sample rate are the main parameters that need to be set.
    
}
audioFormat.channelConfig.uNumChannels = NumberOfChannels;
audioFormat.uSampleRate = SampleRate;
}

private void Start()
{
    // The AudioInputEvent event, that is setup within Wwise to use the Audio Input plug-in, is posted on gameObject.
    // AudioFormatDelegate is called once, and AudioSamplesDelegate is called once per frame until it returns false.
    AkAudioInputManager.PostAudioInputEvent(AudioInputEvent, gameObject, AudioSamplesDelegate, AudioFormatDelegate);
}

    // This method can be called by other scripts to stop the callback
public void StopSound()
{
    IsPlaying = false;
}

private void OnDestroy()
{
    AudioInputEvent.Stop(gameObject);
}

Apply Custom Positioning in Unity

By default, the AkGameObj component is attached to a specific Unity gameObject and uses its transform (with an optional offset) for full positioning. This is usually adequate for many games, such as first-person shooters. However, games with custom camera angles, such as
many third-person games, may find it difficult to accommodate the two aspects of positioning (distance attenuation and spatialization) by simply attaching the audio listener to one game object, such as the main camera in Unity. Other games may want players to experience other custom positioning.

To this end, the AkGameObj component class provides overridable positioning to Unity users. Through the three virtual methods GetPosition(), GetForward(), and GetUpward(), users can derive a subclass from AkGameObj and use that subclass component to customize any number of Unity gameObjects' positioning.

Here is a simple example of how to use a custom component to override the default AkAudioListener behavior. With a third-person project integrated with Wwise, remove the existing AkAudioListener and its associated AkGameObj. Then attach the following script to the MainCamera object, attach AkAudioListener, and finally specify the target Unity gameObject (such as the player avatar) that the audio listener's position will follow. After this, the distance attenuation of all the emitters will rely on the selected target Unity gameObject's position as the listener position (an on-screen distance listener), while the orientation of all the emitters is still based on the main camera orientation as the listener orientation (an off-screen orientation listener).

```csharp
#if !(UNITY_DASHBOARD_WIDGET || UNITY_WEBPLAYER || UNITY_WII || UNITY_WIIU || UNITY_NACL || UNITY_FLASH || UNITY_BLACKBERRY) // Disable under unsupported platforms.

//
// Copyright (c) 2017 Audiokinetic Inc. / All Rights Reserved
//

using UnityEngine;
using System;
using System.Collections.Generic;
```
[AddComponentMenu("Wwise/AkGameObj3rdPersonCam")] [ExecuteInEditMode] //ExecuteInEditMode necessary to maintain proper state of isStaticObject.

public class AkGameObj3rdPersonCam : AkGameObj
{
    public Transform target;  // The position that this camera will be following. User can specify this to the player character's Unity gameObject in the Inspector.

    // Sets the camera position to the player's position to handle distance attenuation.
    public override Vector3 GetPosition ()
    {
        return target.GetComponent<AkGameObj> ().GetPosition ();
    }
}

#endif // #if !(UNITY_DASHBOARD_WIDGET || UNITY_WEBP LAYER || UNITY_WII || UNITY_WIIU || UNITY_NACL || UNITY_FLASH || UNITY_BLACKBERRY) // Disable under unsupported platforms.
Wwise Picker

Wwise Picker  Wwise  Events  Switches  Wwise Picker
Wwise Settings  Edit > Wwise Settings...  Unity  Wwise

Wwise  Wwise Picker  Refresh Project  Wwise
Picker  Wwise  SoundBank  XML

Wwise Picker  Picker

+ -
**SoundBank**

Generate SoundBanks  SoundBank SoundBank  Wwise Picker
SoundBanks  Wwise Unity
SoundBanks generation successful  WwiseUnity: SoundBanks generation has warning(s)  WwiseUnity: SoundBanks generation error  Console  SoundBank

Wwise Settings  Wwise Windows Installation
Path  Mac  Wwise Application  Unity  Generate
SoundBanks  Unity  Wwise
Picker

Wwise Picker  Game Object  Inspector

- Event  AkAmbient
- SoundBank  AkBank
- Switch Value  AkSwitch
- State Value  AkState
- Aux Bus  AkEnvironment
public class WwiseTypesExample : UnityEngine.MonoBehaviour
{
    public AK.Wwise.Bank MyBank = null;
    public AK.Wwise.Event MyEvent = null;
    public AK.Wwise.RTPC MyRTPC = null;

    public void Awake()
    {
        MyBank.Load();
    }

    public void Start()
    {
        MyEvent.Post(gameObject);
    }

    private float CalculateMyValue()
    {
        return (float)System.Math.Sin(System.Math.PI *
         UnityEngine.Time.timeSinceLevelLoad);
    }

    public void Update()
    {
        MyRTPC.SetValue(gameObject, CalculateMyValue());
    }
}
public AK.Wwise.CallbackFlags MyCallbackFlags = null;

public void Start()
{
    MyEvent.Post(gameObject, MyCallbackFlags, EventCallback);
}

private void EventCallback(object cookie, AkCallbackType type, AkCallbackInfo info)
{
    if (type == AkCallbackType.AK_Marker)
    {
        var markerInfo = info as AkMarkerCallbackInfo;
        if (markerInfo != null)
        {
            // ...
        }
    }
}
**Wwise Events Trigger**

Unity Wwise "Trigger On" Unity / Wwise
EventSwitchState Unity

AkTriggerBase C# AkTriggerBase "Trigger On"
triggerDelegate(GameObject in_target)"

Wwise ""

GetComponent<YourTriggerClass>()
().triggerDelegate(GameObject in_target)

```
public class TriggerOnGunHit : AkTriggerBase
{
    void Hit()
    {
        if (triggerDelegate != null)
        {
            triggerDelegate(null);
        }
    }
}
```

```
if (playerIsShot)
{
    GetComponent<TriggerOnGunHit>().Hit();
}
```

TriggerOnGunHit Wwise
AkSoundEngine.PostEvent("GunHit", gameObject) Wwise SDK
Wwise Timeline Integration

Timeline is Unity's cinematic editing tool. It can be used to create gameplay sequences, audio sequences, and other cinematic content.

For more information on Timeline refer to Timeline Docs.

For instructions on how to create a Timeline Asset and Timeline instance, refer to Timeline Usage.
Wwise Timeline Tracks

The Wwise Unity Integration adds two tracks: the **AkRTPC** track and the **AkEvent** track. The **AkRTPC** track is used to set Game Parameter values, and the **AkEvent** track is used to post Wwise Events. **AkRTPC** tracks and **AkEvent** tracks can be added to a Timeline in Unity using the "Add" dropdown button.

![Adding AK tracks to Timeline](image)

**Ak Track Object Bindings**

**AkEvent** tracks and **AkRTPC** tracks have object bindings which can be set to any Game Object. If this is left as None, the Event messages or RTPC messages in the track will be triggered on the Game Object that owns the Timeline (this is the Game Object that has aPlayableDirector component, which is used to trigger the Timeline). If the track binding is set to a different Game Object, the messages will be triggered on that Game Object.

**The AkRTPC Parameter Property**

**AkRTPC** tracks have one property in their property inspector: **Parameter**. This is the Wwise RTPC parameter that will be set from the various clips in the track.
RTPC Track Parameter Property

**Wwise Timeline Playable Clips**

The **AkEvent** track and the **AkRTPC** tracks each hold corresponding clips: the **AkEventPlayable** clip and the **AkRTPCPlayable** clip. These can be added to a track using the track's menu.

**Adding AK clips to AK tracks**

**Timeline Clip Properties**

All clips in Timeline have timing properties that are displayed in the top portion of the inspector. For more information on these properties, refer to Clip Properties.

**AkRTPCPlayable Clip Properties**

The following properties are accessible from the inspector of an **AkRTPCPlayable** clip:
AkRTPCPlayable Clip Properties

- **Set RTPC Globally**: If this is checked, the RTPC will be set globally for all objects.
- **Override Track Object**: If this is checked, the RTPC will be set for the selected Game Object in the RTPC Object property (only available when Set RTPC Globally is unchecked).
- **RTPC Object**: The Game Object for which the RTPC will be updated. If this is set to **None**, the RTPC will be set on the track object (or the Timeline's owner object if the track object is set to None). This is only available when Override Track Object is checked.
- **Animated Value: RTPC Value**: This is the value that will be animated by the RTPC track. In order to begin animating this value you need to arm the track for recording, set the playhead to somewhere within the RTPCPlayable clip, and then edit the value from the property inspector.
Animating RTPC Values from Timeline

Following these steps will insert a keyframe into the RTPC track, below the RTPC clip. You can then use this Unity curve editor to add more keyframes. The keyframes have a context menu that can be used for more precise values.
AkEventPlayable Clip Properties

The following properties are accessible from the inspector of an AkEventPlayable clip:

- **Override Track Object**: This can be checked in order to have the Event emitted from a specific Game Object, different to the track binding object. This will also override the Timeline owner object if the track binding is set to None (see Ak Track Object Bindings).
- **Emitter Object Ref**: The Game Object from which the Event should be emitted (only available when Override Track Object is checked).
- **Event**: The Wwise Event that will be triggered from this clip.
Known Issues & Limitations

Currently scrubbing is only supported in Play mode in the Unity editor. This is due to an issue with Unity Playable callbacks in edit mode. Unity are aware of the issue: 953109. This means that "Play from anywhere" behavior is not supported in edit mode either. If you place the playhead somewhere between the beginning and end of a clip and play the timeline, while in edit mode, the event will not be triggered.
**Wwise Project Setup**

To ensure that Event lengths are properly represented in the AkEvent Tracks, the Wwise project needs to be set up to estimate the duration of its audio Events and JSON metadata must be generated. To enable these project-wide settings, go to the Project Settings' SoundBanks tab. Enable the *Estimated duration* check box within the *Metadata Options* group box and enable the *Generate JSON Metadata* check box within the *SoundBank Settings* group box, as seen below.
Required Project Settings for AkEvent Tracks

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Unity

Unity Unity SoundBank
Settings... /

Wwise Settings

**Wwise Project**
- Wwise Project Path: ...
- Wwise Windows Installation Path: ...

**Asset Management**
- Soundbanks Path* (relative to StreamingAssets folder): ...
- Enable copying of soundbanks at pre-build step
- Enable soundbank generation at pre-build step
- Create WwiseGlobal Game Object
- Automatically add Listener to Main Camera

**In Editor Warnings**
- Show Warning for Missing RigidBody

* Mandatory settings

[OK] [Cancel]
Wwise

Unity Wwise Profile Wwise
Assets > Wwise > Activate Plugins Wwise Release

Debug Audiokinetic

:

- Android
- iOS
- Linux
- Unity Wwise
StreamingAssets

Unity Unity Assets StreamingAssets Unity
<UNITY_PROJECT_ROOT>\Assets\StreamingAssetsUnity Unity StreamingAssets

SoundBanks Audio\GeneratedSoundBanks StreamingAssets Unity Wwise Platform Manager
<UNITY_PROJECT_ROOT>\Assets\StreamingAssets\Audio\GeneratedSoundBank
<>

AkInitializer::basePath SoundBank

Unity SoundBanks Wwise GeneratedSoundBank Wwise Project Settings Windows Mac bank
SoundBanks

SoundBank  StreamingAssets  Wwise  SoundBank  Wwise Settings
StreamingAssets  SoundBank
SoundBank

SoundBank StreamingAssets SoundBank
SoundBank

Wwise iOS iPad iPhone

Unity Wwise
Android

APK Android SoundBank LoadBank() API Unity StreamingAssets SoundBank APK Assets Low-Level IO APK SoundBank

Low-Level IO Android SoundBank SD
AkSoundEngine.AddBasePath() APK APK APK DLC

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
iOS

iOS Unity Unity Editor Build Build Run Unity
Unity Xcode

UNITY_PROJECT_ROOT/Assets/Plugins/iOS

Unity thumb Xcode thumb
Linux

Unity Linux .x8632 .x86_6464

Wwise Unity Integration libSDL2"DLLNotFoundException"

Ubuntu 12.04 libSDL2

- sudo apt-get install build-essential libasound2-dev
- wget http://www.libsdl.org/release/SDL2-2.0.3.tar.gz
- tar -zxvf SDL2-2.0.3.tar.gz
- cd SDL2-2.0.3
- ./configure
- make
- sudo make install
- sudo ldconfig
Wwise Unity » Unity
Unity  Wwise

Wwise  Unity  Wwise  C#

SoundBank  GetPlatformName  SoundBank
iOS  ipod iphone ipad

1. Wwise  Platform Manager "iPod" "iPhone" "iPad" Wwise  Platform Manager

2. Unity  C#  AkBasePathGetter

```csharp
public partial class AkBasePathGetter
{
#if UNITY_IOS
    static partial void GetCustomPlatformName(ref string platformName)
    {
        switch(UnityEngine.iOS.Device.generation)
        {
            case UnityEngine.iOS.DeviceGeneration.iPodTouch1Gen:
            case UnityEngine.iOS.DeviceGeneration.iPodTouch2Gen:
            case UnityEngine.iOS.DeviceGeneration.iPodTouch3Gen:
            case UnityEngine.iOS.DeviceGeneration.iPodTouch4Gen:
            case UnityEngine.iOS.DeviceGeneration.iPodTouch5Gen:
            case UnityEngine.iOS.DeviceGeneration.iPodTouchUnknown:
                platformName = "iPod";
                break;
            case UnityEngine.iOS.DeviceGeneration.iPad1Gen:
            case UnityEngine.iOS.DeviceGeneration.iPad2Gen:
```
case UnityEngine.iOS.DeviceGeneration.iPad3Gen:
case UnityEngine.iOS.DeviceGeneration.iPadMini1Gen:
case UnityEngine.iOS.DeviceGeneration.iPad4Gen:
case UnityEngine.iOS.DeviceGeneration.iPadAir1:
case UnityEngine.iOS.DeviceGeneration.iPadMini2Gen:
case UnityEngine.iOS.DeviceGeneration.iPadMini3Gen:
case UnityEngine.iOS.DeviceGeneration.iPadAir2:
case UnityEngine.iOS.DeviceGeneration.iPadUnknown:
    platformName = "iPad";
    break;

case UnityEngine.iOS.DeviceGeneration.iPhone:
case UnityEngine.iOS.DeviceGeneration.iPhone3G:
case UnityEngine.iOS.DeviceGeneration.iPhone3GS:
case UnityEngine.iOS.DeviceGeneration.iPhone4:
case UnityEngine.iOS.DeviceGeneration.iPhone4S:
case UnityEngine.iOS.DeviceGeneration.iPhone5:
case UnityEngine.iOS.DeviceGeneration.iPhone5C:
case UnityEngine.iOS.DeviceGeneration.iPhone5S:
case UnityEngine.iOS.DeviceGeneration.iPhone6:
case UnityEngine.iOS.DeviceGeneration.iPhone6Plus:
    case UnityEngine.iOS.DeviceGeneration.iPhoneUnknown:
        default:
            platformName = "iPhone";
            break;
    }

#endif

platformName Unity

3. a C#      AkBuildPreprocessor
AkBuildPreprocessor

public class WwiseIOSBuildPreprocessor : IPreprocessBuild, IPostprocessBuild
{
    public int callbackOrder { get { return 0; } }
}

string iPodDestinationSoundBankFolder = string.Empty;
string iPadDestinationSoundBankFolder = string.Empty;
string iPhoneDestinationSoundBankFolder = string.Empty;

public void OnPreprocessBuild(BuildTarget target, string path)
{
    if (target == BuildTarget.iOS)
    {
        AkBuildPreprocessor.CopyToSoundbanks(true, "iPod", iPodDestinationSoundBankFolder);
        AkBuildPreprocessor.CopyToSoundbanks(true, "iPad", iPadDestinationSoundBankFolder);
    }
AkBuildPreprocessor.CopySoundbanks(true, "iPhone", iPhoneDestinationSoundBankFolder);
}

public void OnPostprocessBuild(BuildTarget target, string path)
{
    // deletes soundbanks for iPod, iPad, and iPhone
    DeleteSoundbanks(iPodDestinationSoundBankFolder);
    DeleteSoundbanks(iPadDestinationSoundBankFolder);
    DeleteSoundbanks(iPhoneDestinationSoundBankFolder);
}

4. Wwise "iPhone" "iPod" "iPad" SoundBank
   UNITY_PROJECT_ROOT/Assets/StreamingAssets/Audio/GeneratedSoundBank

5. Unity iOS
6. SoundBank
Wwise Unity
Wwise File Package

Wwise DLC Authoring
Package > DLC
Low-Level IO

Unity Base Path bank

AkInitializer

AkSoundEngine.LoadFilePackage()Wwise

Base Path iOS Android

Android iOS AkSoundEngine.LoadFilePackage()

Android SD

- OBB Android
Wwise Unity
1. Wwise Launcher  Wwise SDK
2. Windows  Mac  Wwise Launcher  Unity
   _Src.zip
3. Windows  Mac

1.  
2.  **Unity**
3.  **Integrated Development Environment (IDE)**
4.  Deployment  API
<table>
<thead>
<tr>
<th>Platform</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Android    | - Unity 5 (Personal  Pro)  
            - Wwise SDK  
            - SDK Wwise SDK  
            - Python 2.7.x  3.xPython  
            - Cygwin (Windows )  
            - Android SDK 32  API 9 64  API 21..  
            - Android NDK r10e.  
            - Apache Ant 1.8.4.  
            - Wwise SDK  
            - Unity  
            - CYGWIN_HOME Cygwin (Windows )  
            - ANDROID_HOME Android SDK  
            - ANDROID_NDK_ROOT Android NDK  
            - ANT_HOME Apache Ant |
| iOS        | - Xcode 7.2  
            - iOS  Wwise SDK  
            - WWISESDK |
| Linux      | - (sudo apt-get install build-essential)  
            - SDL2 (Linux SDL2)  
            - Linux  Wwise SDK  
            - WWISESDK |
| Mac        | - Xcode 7.2  
            - Mac  Wwise SDK  
            - WWISESDK |
<table>
<thead>
<tr>
<th>Platform</th>
<th>IDE Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS4</td>
<td>Visual Studio 2012</td>
</tr>
<tr>
<td>Windows</td>
<td>Visual Studio 2013</td>
</tr>
<tr>
<td>Windows Store</td>
<td>Visual Studio 2015.</td>
</tr>
<tr>
<td>Xbox One</td>
<td>Visual Studio 2012</td>
</tr>
</tbody>
</table>
Wwise SDK  Unity  Assets  Wwise
Unity .unitypackage  Assets
• **StreamingAssets** SoundBank
• **Wwise**
  • **Deployment**
    • API C++ C# Wwise SDK
    • **Dependencies** Unity
    • **Components** Unity
    • **Plug-ins/b>** Unity

  • **Platform**
    • **Architecture**
      • Debug Wwise
      • Profile Wwise
      • Release Wwise
      • DSP Wwise

• **Editor** WwiseUnityIntegration Inspector
• **Tools**
- Wwise
  - AkSoundEngine IDE
    - Common
    - Platform IDE
  - Integration/Assets/Wwise/Deployment
    - API
      - Generated SWIG API
      - Handwritten API
    - Components Unity
    - Plugins Wwise AkSoundEngine
      - <platform>
        - <architecture>
Wwise\AkSoundEngine\Common\BuildWwiseUnityIntegration.py

python BuildWwiseUnityIntegration.py -h
Integrated Development Environment (IDE)

Wwise Unity Integration

WwiseUnityIntegration_version_platform_Src.zip\Wwise\AkSoundEngine\YourPlatform

Xcode IDE

**Xcode Mac iOS**

`$WWISESDK Xcode -w Xcode IDE`

WWISESDK Mac iOS Xcode

AkSoundEngine{platform} Build Settings

User-Defined

WWISESDK ex: /Users/myUser/Wwise/SDK

**Linux**

Linux

- cd <Integration source location>/AkSoundEngine/Common
- ./premake4 --akplatform=Linux gmake
- make -f AkSoundEngineLinux.make config=<config>

<config> debug32profile32release32debug64 profile64 release64 <Integration source location>/Deployment/Plugins/Linux
Wwise\Deployment\Plugins\[Platform] Assets\Wwise Assets
1. Wwise SDK  Unity Windows .dll Mac OS X .bundle iOS .a Android .so Deployment

Unity

C++  Wwise /
Wwise Unity »
Unity Editor

UNITY_PROJECT_ROOT\Assets\Wwise\Logs\BuildWwiseUnityIntegration.log

:: ()::

2013-09-26 09:29:56,490: INFO: BUILDWWISEUNITYINTEGRATION.PY (WINDOWSBuilder): 91: BUILDING: Windows (Win32, Debug) ...

Wwise Unity

WwiseUnityIntegration_version_platform_Src.zip\Wwise\AkSoundEngine\Common\AkSoundEngine\Common\BuildUtil.py

Python logging.handlers

IDE Visual Studio

IDE

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Wwise Unity »
C++  Wwise  /

- Unity  Unity
- Unity  check-out  Unity
- Wwise  Unity

Wwise  Unity  Wwise  Unity  Wwise
Launcher  Wwise

Wwise  Wwise

3  Wwise  Unity
Unity Wwise

Wwise Launcher  Unity  Wwise
Wwise

1. Wwise Unity Wwise
   - Wwise

1. Wwise “Yes”
2. Unity Wwise SoundBank
3. SoundBank Unity StreamingAssets
C++

1. Wwise SDK
2. Unity
3. Unity
4. Unity
5. 

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Wwise Unity
API

Wwise SDK  Unity

- UnloadBank()
- iOS API
  - AK::SoundEngine::iOS::ListenToAudioSessionInterruption()
- Windows
  - GetGameObjectFromPlayingID()
  - Windows 32 64
  - 32 GameObject ID
- PostEvent() GameObject API null GameObject
- PostEvent()
- AK::Monitoring::SetLocalOutput()
  - AkCallbackManager.SetMonitoringCallback()
- AK::SoundEngine::SetPosition()
  - AkSoundEngine.SetObjectPosition()
- PostEvent()
- AK::SoundEngine::DynamicSequence API Unity API
  - SWIG API
    - AK::SoundEngine::DynamicSequence::Open()
    - AkSoundEngine.Open() API
    - AkSoundEngine.DynamicSequenceOpen()
- C++ Unity
  - AkArray::operator[]
  - AkPlaylistArray.ItemAtIndex(uint uiIndex) SWIG C++
- API
  - iOS API
    - AkSpeakerVolumeMatrixCallbackInfo
    - AkSpeakerVolumeMatrixBusCallbackInfo
    - AkBusCallbackFunc
    - AK::SoundEngine::RegisterBusVolumeCallback
    - AK::SoundEngine::RegisterCodec
    - AK::SoundEngine::RegisterGlobalCallback
    - AK::SoundEngine::RegisterPlugin
    - AK::SoundEngine::Query::AkGameObjectsList
    - AK::SoundEngine::Query::GetActiveGameObjects()
    - AK::SoundEngine::Query::GameObject
    - AK::SoundEngine::Query::AkRadiusList
- AK::SoundEngine::Query::GetMaxRadius(AkRadiusList& io_RadiusList)
- Event
  AK::SoundEngine::DynamicDialogue::ResolveDialogueEvent

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Android

- Android
- Android
- OBB Android
- Wwise Unity DLC
iOS

- iOS
- iOS
- Wwise Unity DLC
Linux

- Linux
Windows Store Apps

- Windows Store Apps
Wwise Unity »
Android

AkSoundEngine.Suspend()   AkSoundEngine.WakeupFromSuspend()
AkInitializer

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
OBB Android

OBB  Wwise IO

Android  Unity  Player Settings > Publishing Settings >
Split Application Binary  APK Expansion Files  .obb  zip
StreamingAssets  SoundBank  Android  SoundBank
SoundBank  APK  OBB

OBB  AkSoundEngine.SetBasePath  OBB  OBB
I/O  OBB  CPU
**SoundBank**

in-memory bank AkMemBankLoader.cs  SoundBank

1. SoundBank
2. Inspector SoundBank < b>Bank name
3. Inspector SoundBank Is Localized Bank  
   AkInitializer.cs
4. SoundBank

   AkMemBankLoader.LoadNonLocalizedBank()  AkMemBankLoader
SoundBank LoadLocalizedBank()
- in-memory SoundBank low-level IO zip
- SoundBank streamingmanager_lowlevel
- SoundBank SoundBank
- in-memory SoundBank-loading API API
iOS

Unity Integration

- AkAudioSessionCategorySoloAmbientiPhone: Ring/Silent
- AkAudioSessionCategoryAmbient: AmbientSound Music
  BGM UI
  AkCallbackManager.SetBGMCallback()

Solo Ambient BGM Ambient BGM
BGM

iOS Suspend
WakeupFromSuspend
Wwise Unity »
Windows Store Apps

- Universal Windows Platform
- Windows SoundBank SDK
- SoundBank

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Wwise Unity
Wwise Demo Game

Demonstration scenes, containing the Wwise Unity Integration, are available to download from the Wwise Launcher Unity page under the contextual menu in the "Recent Unity Projects" title. Unity
The Wwise Demo Game is a standalone project. Wwise Launcher
Wwise Launcher  Wwise  Unity

- The generated SoundBanks are included in the package.
- You can find the Wwise Project associated with the scenes under `<DEMO_SCENE_ROOT>/WwiseProject`. Leaving the Wwise project in the game's Assets folder is not recommended, but it was necessary in this Demo for packaging purposes.
The Wwise Demo Game is intended as a way to preview and show how the Wwise Unity Integration can be used in the Unity Editor.

To deploy one of the Wwise Demo Game scenes to a game console or mobile device, follow these steps:

1. Within the Launcher’s Unity tab, select the **Modify Wwise in Project...** option from your Wwise Demo Game Unity Project.
   - 1. Launcher Unity
2. Deployment Platforms **Modify**
3. Unity
4. SoundBank
5. Copy the Generated SoundBanks folder to the StreamingAssets/Audio folder.
6. Unity
First-Person 3D """"For each station, there is a small description on a sign next to the station.

Wwise  Random container Switch Container  
Wwise Picker Window  Box Collider  Switch Value  
Wwise Component Inspector  Window  
"AkAmbient"  
Unity  
Wwise SoundEngine  

AkTriggerButtonPress  AkTriggerBase  
TriggerDelegate  AkTriggerBase  
Wwise Component Inspector  
AkAmbient  
WAV marker  marker  AkAmbient  

SubtitleDemo.cs  
"Game Object" Callback  
Function MarkerCallback  Callback Flag "Marker"  
SubtitleDemo Callback  MarkerCallback  uIdentifier  

 inspector  AkAmbient
EnvironmentZone Box Collider AuxBus Wwise Picker

Wwise Auxiliary Bus Little Sequence "Use game-defined Auxiliary sends"

Wwise EnvironmentZone AuxBus

Environment Portal Environment Portal Auxiliary Bus

Box Collider Ak Environment "z" Ak Environment Portal

Environments Environment Portal inspector

AkEnvironment AkEnvironmentPortal

**Timeline Demo**

This station demonstrates the use of an AkEventTrack and an AkRTPCTrack within a Timeline in Unity. There are two cubes, which, when the button is pressed, are animated towards each other and stopped when they reach impact.

In order to inspect the Timeline, select Window-&gt;Timeline. Then in the Hierarchy, expand the TimelineDemo object, and then expand the Timeline Demo Button object. Then select the Button object. The Timeline editor will now show the Timeline that controls the animation and Wwise Events for the cubes. The Timeline is controlled by the Playable Director component of the Button object.

The Timeline contains two animation tracks, one for each cube. These tracks are used to animate the z position of each cube over time. The Timeline also contains an AkEventTrack and an AkRTPCTrack, marked by a white and red tab, respectively. The AkEventTrack contains two AkEventPlayable clips: the first triggers the PlayCubeMovement Wwise Event, and the next triggers the PlayImpact Wwise Event. The names of these Wwise Events are displayed in the clips. You may need to increase the size of the Timeline editor view and zoom in in order for the name to
be displayed correctly. The PlayCubeMovement Wwise Event plays a sine wave source, which has an RTPC affecting its pitch. The name of this RTPC is CubeAcceleration. The AkRTPCTrack increases this RTPC over time as the cubes move towards each other. This causes the pitch of the sine wave to increase, producing a simple sound effect to indicate the acceleration of each cube towards the other.

This station also demonstrates the Motion feature. Note that there is a game object called "Motion listener" in the player hierarchy. This game object set up the output for the Motion device on supported platforms. Any output needs a set of listeners to receive data. That is why the Motion listener also have a Ak Game Object and a Ak Audio Listener. To enable the Motion effect on the cube impact, two important things needs to be done. First, the impact sound needs to be routed to an output bus using the Wwise Motion ShareSet in the Wwise project. Second, the listener used for the Motion output needs to be added to the listeners of the emitter posting the impact event. Inspect the AkMotionListener script for an example on how to add an output.

To support the Motion feature on android, the manifest of the application must include the vibration permission. Unity generates automatically the manifest based on the content of the application. Adding a call to `Handheld.Vibrate()` will add the desired permission in the manifest.

For more information on the Timeline integration, see Wwise Timeline Integration.
Spatial Audio Scene

This scene is the final product of the Spatial Audio Tutorial.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Wwise Unity  »  Wwise Demo Game
Using Wwise Spatial Audio in Unity

This chapter gives an overview of how to use the Spatial Audio features of the Unity integration. It is broken down into:

- A preparation page you need to follow before going to the tutorials:
  - Preparation for the Spatial Audio Tutorials
    - 1. Create a Unity Project
    - 2. Wwise Project Preparation
    - 3. Unity Project Preparation
- Two independent tutorials:
  - Surface Reflectors Tutorial
  - Rooms and Portals Tutorial
- And a supplementary page addressing the use of obstruction and occlusion:
  - Obstruction and Occlusion

Completion of sections using the Wwise Reflect plug-in require the appropriate license.
Wwise Unity » Wwise Demo Game » Using Wwise Spatial Audio in Unity
Preparation for the Spatial Audio Tutorials

The following steps must be followed beforehand to successfully complete the Surface Reflectors Tutorial and the Rooms and Portals Tutorial:

1. Create a Unity Project
2. Wwise Project Preparation
3. Unity Project Preparation
   - 3.A. Environment
   - 3.B. Character Listener
   - 3.C. Third-Person Emitters
   - 3.D. Scene
1. **Create a Unity Project**

Using the latest version of Wwise and Unity, follow the steps below in order to build your working environment.

1. Launch Unity and create a new project.
2. Close Unity.
3. Start the Wwise Launcher and **integrate Wwise into your Unity project**.
2. Wwise Project Preparation

For the tutorials, you will need a Sound SFX, an Event to play it, and a SoundBank.

1. From the Launcher, open your project in Wwise.
2. Add a Sound SFX under the Actor Mixer Hierarchy’s Default Work Unit. In the integration Wwise Project, we added a dialogue.
   1. Import a sound into it.
   2. In the Sound Property Editor's
      1. General Settings tab, enable Use game-defined auxiliary sends.

![Sound Property Editor General Settings tab](image)

2. Positioning tab, enable positioning and choose 3D. Optionally, add an Attenuation.
Sound Property Editor Positioning tab

3. Right-click on the Sound SFX within the Actor-Mixer Hierarchy, then select **New Event > Play**.

Event Editor

4. Go to the SoundBank layout (shortcut F7) and add a new SoundBank. Drag the Event into the new SoundBank. Here’s how the SoundBank Manager should look in the integration Wwise Project:
SoundBank Manager and Editor

5. Save your project.
### 3. Unity Project Preparation

In this section we will create our game area and the objects in it. We will need a listener, emitters, and two rooms. From the Launcher, open your project in Unity. Open the Wwise Picker (Windows > Wwise Picker), Refresh Project, and Generate SoundBanks.

![](image)

#### Wwise Picker

### 3.A. Environment

1. Create a floor, walls, and ceilings using cubes: **GameObject > 3D Object > Cube.**

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floor</td>
<td>(0, 0, 0)</td>
<td>(0, 0, 0)</td>
<td>(50, 0.5, 50)</td>
</tr>
<tr>
<td>Wall Front Left</td>
<td>(-4.5, 3, -10)</td>
<td>(0, 0, 0)</td>
<td>(7, 6, 0.5)</td>
</tr>
<tr>
<td>Wall Front Middle</td>
<td>(0, 5, -10)</td>
<td>(0, 0, 0)</td>
<td>(2, 2, 0.5)</td>
</tr>
<tr>
<td>Wall Front Right</td>
<td>(2.5, 3, -10)</td>
<td>(0, 0, 0)</td>
<td>(3, 6, 0.5)</td>
</tr>
</tbody>
</table>
2. Add spotlights inside rooms (GameObject > Light > Spotlight).

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spotlight Small Room</td>
<td>(-3, 5.75, -6)</td>
<td>(0, 0, 0)</td>
<td>(1, 1, 1)</td>
</tr>
<tr>
<td>Spotlight Large Room</td>
<td>(11.5, 5.75, 5)</td>
<td>(0, 0, 0)</td>
<td>(1, 1, 1)</td>
</tr>
</tbody>
</table>

1. In the Light component, change:
   1. Range to 30.
   2. Spot Angle to 179.

### 3.B. Character Listener

1. Create a character with the method of your choice.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>MainCharacter</td>
<td>(0, 1.3, -20)</td>
<td>(0, 0, 0)</td>
<td>(1, 1, 1)</td>
</tr>
</tbody>
</table>

1. Remove any Unity Audio Source.
2. Add an Ak Audio Listener component to the camera.

3. Add an Ak Spatial Audio Listener component to the camera.
3.C. Third-Person Emitters

1. Create buttons using cylinders (GameObject > 3D Object > Cylinder).

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button Outside</td>
<td>(-3, 0.75, -15)</td>
<td>(0, 0, 0)</td>
<td>(0.15, 0.5, 0.15)</td>
</tr>
<tr>
<td>Button Small Room</td>
<td>(-3, 0.75, -5)</td>
<td>(0, 0, 0)</td>
<td>(0.15, 0.5, 0.15)</td>
</tr>
<tr>
<td>Button Large Room</td>
<td>(7.5, 0.75, 5)</td>
<td>(0, 0, 0)</td>
<td>(0.15, 0.5, 0.15)</td>
</tr>
</tbody>
</table>

2. Add an Ak Spatial Audio Emitter component.

3. In the Ak Game Obj component:
   1. Enable the Environment Aware option.
   2. Enable the Use Default Listener option.
4. Add an **Ak Ambient** component:
   1. Choose your preferred way to start the sound in **Trigger On**.
   2. Choose the **Play sound** Event in **Event Name**.

5. Add an **Ak Bank** component:
   1. Add the SoundBank created in **2. Wwise Project Preparation**
      to **Bank Name**.
6. Start the game, connect it to Wwise, and open the Profiler layout (shortcut F6).
7. Play the sound from a button. You should hear the sound you imported in the Wwise project.
8. In the Voices Graph tab, you should see the following graph.

![Button Outside Voice Graph with no Effect](image)

**3.D. Scene**

1. Save your Scene to a convenient place.
2. The final look of the scene is shown in the following image. This scene is available with the Unity integration package. Colors were added to elements of the scene for convenience. A mobile first-person controller was also added.
Tutorial Unity Scene

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Surface Reflectors Tutorial

In the following steps, this tutorial will show you how to use the new Reflect plug-in with Spatial Audio. You will need a Reflect plug-in license to make the project work.

- **A. Wwise Project**
- **B. Spatial Audio Emitter**
- **C. Surface Reflector Component**
  - C.1. Use Existing Meshes
  - C.2. Alternative: Create a New Volume

**Note:** This tutorial presumes that you have completed the Preparation for the Spatial Audio Tutorials. However, it does not consider if the Rooms and Portals Tutorial was done; both tutorials are independent.
A. Wwise Project

We need to update our wwise project with an Auxiliary Bus with the Reflect plug-in and Acoustic Textures.

1. Add an Auxiliary Bus under the Master Audio Bus.
   1. In the **Auxiliary Bus Property Editor**, under the **Effects** tab, add the Wwise Reflect effect.

   ![](image.png)  
   **Auxiliary Bus Property Editor Effects tab for Reflect**

   2. Under the **Positioning** tab, enable positioning and choose 2D.
Auxiliary Bus Property Editor Positioning tab for Reflect

2. Import Reflect Acoustic Textures from: Project > Import Factory Assets...
   1. They will be added to the **Virtual Acoustics** folder in the **ShareSets** tab of the **Project Explorer** view.
Factory Reflect Acoustic Textures in the Project Explorer ShareSets tab

2. (optional) You can add custom Acoustic Textures in the Virtual Acoustics folder under Default Work Unit.
3. Save your project.
B. Spatial Audio Emitter

We need to modify the spatial audio emitter to use our newly created reflect aux bus.

1. Refresh your Wwise project in the Wwise Picker: Windows > Wwise Picker
   1. Generate SoundBanks

   ![Wwise Picker](image)

   Wwise Picker

2. Modify the **Ak Spatial Audio Emitter** component of each button.
   1. Pick the Reflect Auxiliary Bus for **Reflect Aux Bus**.
   2. Choose 2 for the **Reflections Order**.
   3. Choose 1 for the **Reflections Aux Bus Gain**.
   4. Choose 100000 for the **Reflection Max Path Length**.
   5. Check the **Draw First Order Reflections** and **Draw Second Order Reflections** under **Debug Draw**.
Ak Spatial Audio Emitter for Surface Reflector
C. Surface Reflector Component

You can simulate early reflections with the Ak Surface Reflector component. One way to have surface reflectors is to use existing meshes of the game. If the shape is too complex, you may want to add a new object as a surface reflector.

C.1. Use Existing Meshes

The advantages of using the existing meshes are that you don't need to create new objects and each mesh can have a different acoustic texture. The disadvantages are that if you have a complex figure, you may send too much triangles to the Spatial Audio API and this could slow down your game. Also, another disadvantage is that each mesh only gets assigned one texture. In the case of the this tutorial, this means that it is not possible to have a different acoustic texture on the outside than on the inside of the rooms. In the scene provided by the unity integration, this is the method used for surface reflectors.

1. Select all the walls, ceiling and floor from section 3.A. Environment and add an Ak Surface Reflector component.
   1. In the Acoustic Texture parameter, choose an acoustic texture or leave it at None to have an unfiltered reflection.

   ![Ak Surface Reflector component]

2. Start the game.
   1. Since we have enabled the drawing of reflections under Debug Draw in section , you should see rays going from the emitter to the listener in the Scene window. (The ceiling was removed in the following image to see the rays clearly) The blue rays are first order reflections, i.e. they reflect from one surface before reaching the listener, and the yellow rays are second order reflections. The name of the triangles are displayed at the reflection point. A name is made up of the game object's name
and the triangle's number. A cube has 12 triangles, two per face.

Top view of early reflection drawings for existing mesh surface reflectors

2. You can see the rays in the Game window by enabling Gizmos; as we can see in the next image. From this point of view, we can also see that the Debug Draw option draws the triangles of the surfaces that are being reflected on. Leaving the ceiling in this view, we can see that the sound will also reflect from the ceiling on triangles 7 and 6.
First person view of early reflection drawings for existing mesh surface reflectors

3. Connect the game in Wwise and go to the Profiler Layout. You should see a similar graph when Button Small Room is emitting.
**Button Small Room Voice Graph with Reflect Effect**

4. Double click on the Auxiliary Bus with the Reflect Effect in the graph. Navigate to the Effects tab and double click on the Reflect Effect. When playing the sound, you should see the current reflections in the graph and the list of the Reflect Effect Editor. In the following image, there is a Drywall acoustic texture for all the walls and the ceiling and a Tile acoustic texture for the floor. When there are two textures in the list, it means that the reflection is a second order one.

![Reflect Effect Editor View](image)

**C.2. Alternative: Create a New Volume**

Creating a new game object with no mesh renderer can simplify a complex shape. In this optional section, we will show you how to have a surface reflector volume for the interior of the small room. You can also mix solutions by having some meshes be Surface Reflectors and having an object with no mesh renderer as well. Having each mesh be a surface reflector to have different texture per wall inside of the house and
adding and exterior volume to have a completely different texture on the outside of the house. It is also possible to use **Quads** instead of cubes to have a different texture wherever desired. But be careful with intersections when using quads; you don't want your sound to get out of your shape.

1. Create a simpler unrendered mesh using a cube: GameObject > 3D Object > Cube

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Room Interior</td>
<td>(-2, 2.875, -6)</td>
<td>(0, 0, 0)</td>
<td>(11, 5.25, 7.5)</td>
</tr>
</tbody>
</table>

1. Remove the **Mesh Renderer** component
2. Check the **Is Trigger** in the **Box Collider** component
3. add an Ak **Surface Reflector**.

Start the game.

1. Since we simplified the shape of our room, the door is now part of the reflective surface. We don't have any reflections from Button Small Room if we are standing outside. We even get a reflection from Button Outside on the door opening. You may have noticed the name of the reflection point is now referencing to Small Room Interior.
Top view of early reflection drawings for a new surface reflector volume when the emitter is outside

2. Entering the small room, Button Small Room's debug drawings appear and the ones for Button Outside disappear.
Top view of early reflection drawings for a new surface reflector volume when the emitter is inside
Rooms and Portals Tutorial

This tutorial will show you how to use Rooms and Portals with Spatial Audio. The following sections detail each step in the tutorial:

- A. Wwise Project
- B. Spatial Audio Emitter
- C. Rooms
- D. Portals
- E. Portals and Reverb
- F. Surface Reflectors and Reverb

Note: This tutorial presumes that you have completed the Preparation for the Spatial Audio Tutorials. However, it does not consider if the Surface Reflectors Tutorial was done; both tutorials are independent. If you did the Surface Reflectors Tutorial and wish to continue with this tutorial, you can do so without changing anything to your scene except for the optional step of C.2. Alternative: Create a New Volume, which should be reverted. If you wish to start anew, and you've done the Surface Reflectors Tutorial, you can still keep the same scene and just remove any Ak Surface Reflector components.
A. Wwise Project

For the rooms and portals tutorial, we will need to add Reverb Effects and modify Obstruction curves to hear diffraction through a portal when losing sight of an emitter.

1. Add two Auxiliary Busses under the **Master Audio Bus** called SmallRoom and LargeRoom. In the **Auxiliary Bus Property Editor**, under the **Effects** tab, add the Wwise RoomVerb effect. I chose two different factory presets: Rooms/Room_Medium for SmallRoom and Cathedrals/Medium for LargeRoom.

![Auxiliary Bus Property Editor Effects tab for rooms](image)

2. Under the **Positioning** tab, enable positioning and choose 3D.
Auxiliary Bus Property Editor Positioning tab for rooms

2. Project > Project Settings > Obstruction/Occlusion

1. Change the curves:

<table>
<thead>
<tr>
<th>Curve</th>
<th>Point 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Obstruction Volume</td>
<td>0</td>
</tr>
<tr>
<td>Obstruction LPF</td>
<td>0</td>
</tr>
</tbody>
</table>

2. Here's how the Obstruction Volume curve looks like:
Obstruction/Occlusion curves in the Wwise Project Settings

3. Save your project.
B. Spatial Audio Emitter

We need to modify the spatial audio emitter to use our newly created reflect aux bus.

1. Refresh your Wwise project in the Wwise Picker: Windows > Wwise Picker
   1. Generate SoundBanks

   ![Wwise Picker](image)

   **Wwise Picker**

2. Modify the **Ak Spatial Audio Emitter** component of each button.
   1. Apply a gain of 1 for the **Room Reverb Aux Bus Gain** parameter.
   2. Check **Draw Sound Propagation** under **Debug Draw** and uncheck all the others.
Ak Spatial Audio Emitter for Rooms and Portals

3. We will use rooms in the next section, so we need to add a Rigidbody component to our emitter; as explained in the warning message on the Ak Game Obj component.
   1. Click on Add Rigidbody

Ak Game Obj component
C. Rooms

Each of the rooms will have their own room reverb. To do so, we will use the Ak Room component.

1. Create unrendered meshes using cubes: GameObject > 3D Object > Cube

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Room Interior</td>
<td>(-2, 2.875, -6)</td>
<td>(0, 0, 0)</td>
</tr>
<tr>
<td>Large Room Interior</td>
<td>(11.5, 2.875, 3.25)</td>
<td>(0, 0, 0)</td>
</tr>
</tbody>
</table>

1. Remove the Mesh Renderer component.
2. Check the Is Trigger in the Box Collider component.
3. Add an Ak Room component to the Small and Large Room Interior Volumes.
   1. Pick the corresponding SmallRoom or LargeRoom Auxiliary Busses for Reverb Aux Bus.
   2. If you added a Rigidbody to your emitters, you don't need one here. If not, click on Add Rigidbody.

![Ak Room component](image.png)

Ak Room component

2. Start the game, connect to Wwise and go to the Game Object Profiler layout
   1. Watch all the emitters and the listener.
   2. Open a Game Object 3D Viewer view. You should see each emitter in their respective rooms. The next image is a top view of the scene. The listener and Button Outside are not in a room, so they are put by default in the "Outdoors" room. If everything is in the Outdoors room instead of their respective rooms, it means spatial audio is disabled. You must have forgotten to add...
an Ak Spatial Audio Listener component to the listener. Follow step 3.B.

Emitters in their respective rooms and the Listener Outdoors

3. Move the listener to a room and see the room name change under your listener game object in the Game Object 3d Viewer. In the following image, the listener is in the large room.
Emitters in their respective rooms and the Listener in the Large Room Interior

3. Press the button in one of the rooms to hear the reverb.
   1. In the small room, the voice graph should look like this:
2. When a listener is in a different room than the emitter, the sound is completely occluded. You will need to add portals to hear the sound coming from rooms through desired openings.

   To add a reverb outside, add a Room around the entire area. Make sure that the Room has a lower priority than the Small Room Interior and Large Room Interior.
D. Portals

Each Room needs a Portal to be connected to another area. We need two Portals: one on the door between the outside area and the small Room and one between both Rooms.

1. Create two Ak Room Portal components: GameObject > Wwise > Room Portal

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Position</th>
<th>Rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outside Portal</td>
<td>(0, 2, -10)</td>
<td>(0, 0, 0)</td>
</tr>
<tr>
<td>Inside Portal</td>
<td>(3.75, 2, -4.5)</td>
<td>(0, 90, 0)</td>
</tr>
</tbody>
</table>

2. In the Ak Room Portal component:
   1. **Open On** Start.
   2. **Close On** Nothing.
   3. Make sure that the Back Room and Front Room display the right **Ak Room** components.

3. This is how the Inside Portal Ak Room Portal component will look like:

   ![Ak Room Portal component]

4. In the **Scene** window, a Portal is represented with a yellow ribbon around it indicating its size and the orientation in which it should be placed. The red line shows the separation between front and back areas of the Portal. The front is in the same direction as the local z axis.
5. Start the game. You should already see the Draw Sound Propagation drawings indicating where the sound will be coming from through the portal. The sphere on the left comes from the small room emitter and the one on the right from the large room emitter. You can see the latter is actually coming from the Portal connecting the small and large Rooms. The sound propagation is represented by red and blue spheres that change in size depending on the wet and dry diffraction angles respectively.
Game window at Start

1. Connect to Wwise.
2. Play the button outside and go inside the small room.
   1. You should see the same sound propagation drawings coming from the outside emitter through the portal connecting with the outside.

Sound Propagation drawings from Button Outside when the listener is inside Small Room Interior

2. Move in and out of sight to hear the diffraction applied on the sound. You will hear more or less diffraction depending
on the angle of the listener vs. the portal. In the next image, we are watching the listener and Button Outside. You can see a top view of the scene in the Game Object 3D Viewer. In dark red, we can see the portals. The one in the middle is the Outside Portal, the area on top of the Portal is the Small Room Interior and the area on the bottom is the outside. The Listener is in the Small Room Interior and the playing emitter is Button Outside. On the image, you can see the sound propagation in green between the listener and the emitter. The Diffraction angle is 103.3. Also, you can see the virtual position of the Button Outside emitter on the right. That's where the sound you hear will go through the portal.

Portal diffraction angle on Game Object 3D Viewer

Note: At this point, if you change the position of the rooms
or multi-edit portals, the front and back rooms will not update, unless you open each individual AkRoomPortal inspector. In a scene with a lot of portals, this is not convenient, so you can use the AkRoomPortal Baker window we added as an example in this tutorial. Open the window from the menu: Wwise > AkRoomPortal Baker... Click the bake button to update the front and back rooms of all the portals in the scene.
E. Portals and Reverb

Sound emitted through Portals can also use the reverb from the current Room the listener is in.

1. Open the SmallRoom Auxiliary Bus Property Editor and check **Use game-defined auxiliary sends** in the General Settings tab. This will send the small Room reverb to other reverbs in the scene.

2. When playing the small room emitter, and going into the large room, you will see the small room's reverb feeding into the large room's reverb.
Button Small Room reverb sending to Large Room Interior room's reverb on the Voices Graph
F. Surface Reflectors and Reverb

It is also possible to feed early reflections into the reverb of a Room. Let's add surface reflectors in our scene.

1. Following section **Surface Reflectors Tutorial**, 
   1. Add an Auxiliary Bus with the Reflect Effect.
   2. Link each **Ak Spatial Audio Emitter** to the new Reflect Auxiliary Bus.
   3. Add **Ak Surface Reflector** components on all the walls and the floor.

2. In the Wwise project, open the Auxiliary Bus with the Reflect Effect applied to it.
   1. In the General Settings tab, check **Use game-defined auxiliary sends**.

![Auxiliary Bus Property Editor General Settings tab](image)

**Auxiliary Bus Property Editor General Settings tab to send early reflection to the room reverb**

3. Play the scene and press the button in the small Room. With the
player in the small Room, here is the Voices Graph we see:

![Voices Graph]

**Early reflections in the small room are sent to the small room's reverb in the Voices Graph**

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by *doxygen* 1.6.3
Wwise Unity » Wwise Demo Game » Using Wwise Spatial Audio in Unity
Obstruction and Occlusion

It is possible to obstruct or occlude sounds in Unity. See the following sections for details:

- A. Emitter Obstruction/Occlusion
- B. Portal Obstruction
A. Emitter Obstruction/Occlusion

An emitter can be obstructed or occluded in Unity when the **Ak Emitter Obstruction Occlusion** component is added to its GameObject. When your map doesn't use spatial audio, that is it doesn't have any **Ak Room** components, the **Ak Emitter Obstruction Occlusion** component will only use occlusion. In a spatial audio scene, this same component will use obstruction with the spatial audio listener only; the GameObject with the **Ak Spatial Audio Listener** component. Emitter obstruction is applied to emitters that are in the same room as the spatial audio listener.

1. Add an **Ak Emitter Obstruction Occlusion** component to Button Outside.
   1. In **Layer Mask**, select layers that would block audio. In the SpatialAudioTutorial scene provided with the integration, we have put the first person character on a user created layer called "Player" and the GameObjects with **AkRoom** or **AkRoomPortal** components on a user created layer called "Ignore Audio Raycast". These layers are not selected in the **Layer Mask** option.
Layer Mask options for the Ak Emitter Obstruction Occlusion component

2. Play the scene.
   1. Play Button Outside.
   2. Go behind the Barrier GameObject to hear it occluded or obstructed depending on the presence of any GameObjects with the Ak Room component in your scene.
B. Portal Obstruction

Sound emitted through portals can also be obstructed. Use the **Ak Room Portal Obstruction** component on a game object with an **Ak Room Portal** component to do so. See section **Rooms and Portals Tutorial** to add rooms and portals to your scene, if not done already.

1. Add an **Ak Room Portal Obstruction** component to Outside Portal.
   1. In **Layer Mask**, select layers that would block audio. In the SpatialAudioTutorial scene provided with the integration, we have put the the GameObjects with **AkRoom** components on a user created layer called "Ignore Audio Raycast". This layer is not selected in the **Layer Mask** option.

![Ak Room Portal Obstruction component](image1)

![Layer Mask options for the Ak Room Portal Obstruction component](image2)

2. Play the scene.
   1. Play Button Small Room.
2. Go behind the Barrier GameObject to obstruct the portal.
Wwise Unity
- Unity DllNotFoundException
- Wwise Profiler
- —— Unity
- Mac Wwise SoundBank —— Wwise_IDS.h
- Mac Unity Console ""
- Xbox One ""
Unity DllNotFoundException

Windows Unity AkSoundEngine DllNotFoundException

- DirectX
- Wwise-Unity Integration Debug config Microsoft Visual Studio
  2010 Debug Redistributables Profile Debug config
- Windows  Mac  Editor
- SoundBank  Unity  Wwise  Generated
  SoundBanks  SoundBank  StreamingAssets
  Wwise  SoundBank
- Sound Engine  Sound Engine  Script Execution
  Order menu  Edit > Project Settings > Script Execution Order
  AkInitializer  AkTerminator
- Unity ......
- Wwise Profiler  Wwise  F7 Capture Log
- Wwise Profiler  SoundBank  Profiling SettingsAlt-G  SoundBank

- Wwise Profiler  Capture Log  Event
  SoundBank  Event  AkEventAkAmbient
  AkSoundEngine.PostEvent
Wwise Profiler

Windows

- Unity background Run menu File > Build Settings > Player Settings
- 24024 Wwise
- Wwise-Unity Plug-in Debug Profile
- Task Manager "adb.exe" Android TCP
  Android Android Google

- Wwise Remote Connection IP Connect To IP

- 24024 traffic
Unity

Unity   Wwise: Error during installation: Access to the path is denied

- **Assets > Wwise > Install Plugins** Debug Profile Release
  - Wwise Setup   Unity Integration
    - Unity Editor   Scene
  - Unity Plug-in   Debug Profile Release   unity_wwiseids_error
    - Mac    Wwise   SoundBank   ——   Wwise_IDS.h
    - Mac    Wwise   SoundBank   Wwise_IDS.h

- Wwise
- SoundBanks
- Header file path   SoundBank
Wwise  AkSoundEngine
Multiple plug-ins with the same name 'aksoundengine' (found at 'Assets/Wwise/Deployment/Plugins/Mac/Release/AkSoundEngine.bundle' and 'Assets/Wwise/Deployment/Plugins/Mac/Debug/AkSoundEngine.bundle').
Xbox One ""

Xbox One Unity  Wwise  Assets > Project
Settings > Audio "Disable audio"

Unity 5.0.2  "Disable audio"  AkInitializer.cs

AkPlatformInitSettings platformSettings = new AkPlatformInitSettings();
   AkSoundEngine.GetDefaultPlatformInitSettings(platformSettings);
   platformSettings.uLEngineDefaultPoolSize = (uint)lowerPoolSize * 1024;
   platformSettings.fLEngineDefaultPoolRatioThreshold = memoryCutoffThreshold;

AkPlatformInitSettings platformSettings = new AkPlatformInitSettings();
   AkSoundEngine.GetDefaultPlatformInitSettings(platformSettings);
   platformSettings.uLEngineDefaultPoolSize = (uint)lowerPoolSize * 1024;
   platformSettings.fLEngineDefaultPoolRatioThreshold = memoryCutoffThreshold;
#if UNITY_XBOXONE && !UNITY_EDITOR
   platformSettings.uMaxXMAVoices = 0;
#endif

XMA
<table>
<thead>
<tr>
<th>Class Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AK::Wwise::AcousticTexture</td>
</tr>
<tr>
<td>AK::Wwise::AuxBus</td>
</tr>
<tr>
<td>AK::Wwise::Bank</td>
</tr>
<tr>
<td>AK::Wwise::BaseGroupType</td>
</tr>
<tr>
<td>AK::Wwise::BaseType</td>
</tr>
<tr>
<td>AK::Wwise::CallbackFlags</td>
</tr>
<tr>
<td>AK::Wwise::Event</td>
</tr>
<tr>
<td>AK::Wwise::RTPC</td>
</tr>
<tr>
<td>AK::Wwise::State</td>
</tr>
<tr>
<td>AK::Wwise::Switch</td>
</tr>
<tr>
<td>AK::Wwise::Trigger</td>
</tr>
<tr>
<td>--------------------</td>
</tr>
<tr>
<td>AkAmbient</td>
</tr>
<tr>
<td>AkAudioListener</td>
</tr>
</tbody>
</table>
AkBank

AkCallbackManager

AkEmitterObstructionOcclusion

AkEnvironment

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
<table>
<thead>
<tr>
<th>AkEnvironmentPortal</th>
</tr>
</thead>
<tbody>
<tr>
<td>AkEvent</td>
</tr>
<tr>
<td>AkEventCallbackMsg</td>
</tr>
<tr>
<td>AkGameObj</td>
</tr>
<tr>
<td>AkInitializer</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>AkMemBankLoader</td>
</tr>
<tr>
<td>AkRoom</td>
</tr>
<tr>
<td>AkRoomPortal</td>
</tr>
<tr>
<td>AkRoomPortalObstruction</td>
</tr>
<tr>
<td>AkSpatialAudioEmitter</td>
</tr>
<tr>
<td>AkSpatialAudioListener</td>
</tr>
<tr>
<td>AkState</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>AkSurfaceReflector</td>
</tr>
<tr>
<td>AkSwitch</td>
</tr>
<tr>
<td>Ak Terminator</td>
</tr>
<tr>
<td>AkTriggerBase</td>
</tr>
</tbody>
</table>
AK::Wwise::AcousticTexture
AK::Wwise::AcousticTexture

This type represents an Acoustic Texture. ...

AK::Wwise::AcousticTexture

AK::Wwise::BaseType

AK::Wwise::AcousticTexture
This type represents an Acoustic Texture.
AK::Wwise::AuxBus
AK::Wwise::AuxBus

This type represents an auxiliary send in the Master-Mixer Hierarchy. ...
This type represents an auxiliary send in the Master-Mixer Hierarchy.
AK::Wwise::Bank

This type can be used to load/unload SoundBanks. ...
This type can be used to load/unload SoundBanks.
AK::Wwise::BaseGroupType
AK::Wwise::BaseGroupType

This type represents the base for all Wwise Types that also require a group GUID, such as State and Switch. ...

AK::Wwise::BaseGroupType

AK::Wwise::BaseType

AK::Wwise::BaseGroupType

AK::Wwise::State

AK::Wwise::Switch
This type represents the base for all Wwise Types that also require a group GUID, such as **State** and **Switch**.
AK::Wwise::BaseType
AK::Wwise::BaseType

This type represents the base for all Wwise Types that require a GUID.

...
This type represents the base for all Wwise Types that require a GUID.
AK::Wwise::CallbackFlags
AK::Wwise::CallbackFlags

This type represents the values of the flags used when posting an Event with a callback. ...
This type represents the values of the flags used when posting an Event with a callback.
AK::Wwise::Event
AK::Wwise::Event

This type can be used to post Events to the sound engine...
<table>
<thead>
<tr>
<th>uint</th>
<th><strong>Post</strong> (GameObject gameObject)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Posts this <strong>Event</strong> on a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>uint</th>
<th><strong>Post</strong> (GameObject gameObject, CallbackFlags flags, AkCallbackManager.EventCallback callback, object cookie=null)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Posts this <strong>Event</strong> on a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>uint</th>
<th><strong>Post</strong> (GameObject gameObject, uint flags, AkCallbackManager.EventCallback callback, object cookie=null)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Posts this <strong>Event</strong> on a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>void</th>
<th><strong>ExecuteAction</strong> (GameObject gameObject, AkActionOnEventType actionOnEventType, int transitionDuration, AkCurveInterpolation curveInterpolation)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Executes various actions on this event associated with a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>void</th>
<th><strong>PostMIDI</strong> (GameObject gameObject, AkMIDIPostArray array)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Posts MIDI Events on this <strong>Event</strong> associated with a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>void</th>
<th><strong>PostMIDI</strong> (GameObject gameObject, AkMIDIPostArray array, int count)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Posts MIDI Events on this <strong>Event</strong> associated with a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>void</th>
<th><strong>StopMIDI</strong> (GameObject gameObject)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stops MIDI Events on this <strong>Event</strong> associated with a GameObject.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>void</th>
<th><strong>StopMIDI</strong> ()</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stops all MIDI Events on this <strong>Event</strong>.</td>
</tr>
</tbody>
</table>
This type can be used to post Events to the sound engine.
AK::Wwise::RTPC
AK::Wwise::RTPC

This type can be used to set game parameter values to the sound engine. ...

AK::Wwise::RTPC

AK::Wwise::BaseType

AK::Wwise::RTPC
This type can be used to set game parameter values to the sound engine.
AK::Wwise::State
AK::Wwise::State

This type can be used to set Wwise States. ...
This type can be used to set Wwise States.
AK::Wwise::Switch
AK::Wwise::Switch

This type can be used to set **Switch** values on gameobjects. ...
This type can be used to set **Switch** values on gameobjects.
AK::Wwise::Trigger
AK::Wwise::Trigger

This type can be used to post triggers to the sound engine. ...
This type can be used to post triggers to the sound engine.
AkAmbient

Use this component to attach a Wwise Event to any object in a scene. The sound can be started at various moments, dependent on the selected Unity trigger. This component is more useful for ambient sounds (sounds related to scene-bound objects) but could also be used for other purposes. Since AkAmbient has AkEvent as its base class, it features the play/stop, play multiple, stop multiple and stop all buttons for previewing the associated Wwise event. ...

AkAmbient

AkEvent

AkAmbient
<table>
<thead>
<tr>
<th>**<code>c#</code></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>int</strong> <code>eventID = 0</code></td>
</tr>
<tr>
<td>ID of the Event as found in the WwiseID.cs file.</td>
</tr>
<tr>
<td><strong>GameObject</strong> <code>soundEmitterObject = null</code></td>
</tr>
<tr>
<td>Game object onto which the Event will be posted. By default, when empty, it is posted on the same object on which the component was added.</td>
</tr>
<tr>
<td><strong>bool</strong> <code>enableActionOnEvent = false</code></td>
</tr>
<tr>
<td>Enables additional options to reuse existing events. Use it to transform a Play event into a Stop event without having to define one in the Wwise Project.</td>
</tr>
<tr>
<td><strong>AkActionOnEventType</strong> <code>actionOnEventType = AkActionOnEventType.AkActionOnEventType_Stop</code></td>
</tr>
<tr>
<td>Replacement action. See AK::SoundEngine::ExecuteEventOnAction().</td>
</tr>
<tr>
<td><strong>AkCurveInterpolation</strong> <code>curveInterpolation = AkCurveInterpolation.AkCurveInterpolation_Linear</code></td>
</tr>
<tr>
<td>Fade curve to use with the new Action. See AK::SoundEngine::ExecuteEventOnAction().</td>
</tr>
<tr>
<td><strong>float</strong> <code>transitionDuration = 0.0f</code></td>
</tr>
<tr>
<td>Duration of the fade. See AK::SoundEngine::ExecuteEventOnAction().</td>
</tr>
<tr>
<td><strong>const int</strong> <code>MAX_NB_TRIGGERS = 32</code></td>
</tr>
<tr>
<td>Since our mask is a 32 bits integer, we can't have more than 32 triggers.</td>
</tr>
<tr>
<td><strong>List&lt; int &gt;</strong> <code>triggerList = new List&lt;int&gt;() { START_TRIGGER_ID }</code></td>
</tr>
<tr>
<td>List containing the enabled triggers.</td>
</tr>
<tr>
<td><strong>bool</strong> <code>useOtherObject = false</code></td>
</tr>
</tbody>
</table>
| This property is usefull only when used with colliders. When enabled, the target of the action
will be the other colliding object. When disabled, will be the current object.
<table>
<thead>
<tr>
<th>static Dictionary&lt; uint, string &gt;</th>
<th>triggerTypes = AkTriggerBase.GetAllDerivedTypes ()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Will contain the types of all the triggers derived from <strong>AkTriggerBase</strong> at runtime.</td>
<td></td>
</tr>
</tbody>
</table>
Use this component to attach a Wwise Event to any object in a scene. The sound can be started at various moments, dependent on the selected Unity trigger. This component is more useful for ambient sounds (sounds related to scene-bound objects) but could also be used for other purposes. Since AkAmbient has AkEvent as its base class, it features the play/stop, play multiple, stop multiple and stop all buttons for previewing the associated Wwise event.

- inspector AkAmbient
- AkGameObj
- AkEvent
- Integration Details - Events (Note: This is described in the Wwise SDK documentation.)
AkAudioListener

Add this script on the game object that represent a listener. This is normally added to the Camera object or the Player object, but can be added to any game object when implementing 3D busses.

isDefaultListener determines whether the game object will be considered a default listener - a listener that automatically listens to all game objects that do not have listeners attached to their AkGameObjListenerList's. ...
Add this script on the game object that represent a listener. This is normally added to the Camera object or the Player object, but can be added to any game object when implementing 3D busses. IsDefaultListener determines whether the game object will be considered a default listener - a listener that automatically listens to all game objects that do not have listeners attached to their AkGameObjListenerList's.

- Integrating Listeners (Note: This is described in the Wwise SDK documentation.)
AkBank

Loads and unloads a SoundBank at a specified moment. Vorbis sounds can be decompressed at a specified moment using the decode compressed data option. In that case, the SoundBank will be prepared.

AkUnityEventHandler
<table>
<thead>
<tr>
<th>Method Signature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>override void HandleEvent (GameObject in_gameObject)</td>
<td>Loads the SoundBank.</td>
</tr>
<tr>
<td>void UnloadBank (GameObject in_gameObject)</td>
<td>Unloads a SoundBank.</td>
</tr>
<tr>
<td>Type</td>
<td>Variable</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------</td>
</tr>
<tr>
<td>string</td>
<td>bankName = &quot;&quot;</td>
</tr>
<tr>
<td>bool</td>
<td>loadAsynchronous = false</td>
</tr>
<tr>
<td>bool</td>
<td>decodeBank = false</td>
</tr>
<tr>
<td>bool</td>
<td>saveDecodedBank = false</td>
</tr>
<tr>
<td>List&lt; int &gt;</td>
<td>unloadTriggerList = new List&lt;int&gt;() { AkUnityEventHandler.DESTROY_TRIGGER_ID }</td>
</tr>
<tr>
<td>const int</td>
<td>MAX_NB_TRIGGERS = 32</td>
</tr>
<tr>
<td>List&lt; int &gt;</td>
<td>triggerList = new List&lt;int&gt;() { START_TRIGGER_ID }</td>
</tr>
<tr>
<td>bool</td>
<td>useOtherObject = false</td>
</tr>
<tr>
<td>static Dictionary&lt; uint, string &gt;</td>
<td><code>triggerTypes = AkTriggerBase.GetAllDerivedTypes()</code></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Will contain the types of all the triggers derived from <code>AkTriggerBase</code> at runtime.</td>
</tr>
</tbody>
</table>
Loads and unloads a SoundBank at a specified moment. Vorbis sounds can be decompressed at a specified moment using the decode compressed data option. In that case, the SoundBank will be prepared.
AkCallbackManager

This class manages the callback queue. All callbacks from the native Wwise SDK go through this queue. The queue needs to be driven by regular calls to `PostCallbacks()`. This is currently done in `AkInitializer.cs`, in `LateUpdate()`. ...
static void SetMonitoringCallback (AkMonitorErrorLevel in_Level, MonitoringCallback in_CB)

Call this to set a function to call whenever Wwise prints a message (warnings or errors).

static void SetBGMCallback (BGMCallback in_CB, object in_cookie)

static int PostCallbacks ()
This class manages the callback queue. All callbacks from the native Wwise SDK go through this queue. The queue needs to be driven by regular calls to `PostCallbacks()`. This is currently done in AkInitializer.cs, in LateUpdate().
AkEmitterObstructionOcclusion

Obstructs/Occludes the emitter of the current game object from its listeners if at least one object is between them. ...

AkObstructionOclusion
<table>
<thead>
<tr>
<th>LayerMask</th>
<th><strong>LayerMask</strong> = -1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Indicates which layers act as obstructers/occluders.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>float</th>
<th><strong>refreshInterval</strong> = 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The number of seconds between obstruction/occlusion checks.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>float</th>
<th><strong>fadeTime</strong> = 0.5f</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The number of seconds for fade ins and fade outs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>float</th>
<th><strong>maxDistance</strong> = -1.0f</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The maximum distance at which to perform obstruction/occlusion. A negative value will be interpreted as infinite distance.</td>
</tr>
</tbody>
</table>
Obstructs/Occludes the emitter of the current game object from its listeners if at least one object is between them.

The current implementation does not support occlusion.
AkEnvironment

Use this component to define a reverb zone. This needs to be added to a collider object to work properly. inspector AkEnvironment

AkEnvironmentPortal ...
class AkEnvironment_CompareBySelectionAlgorithm
Use this component to define a reverb zone. This needs to be added to a collider object to work properly. **inspector AkEnvironment**

**AkEnvironmentPortal**.

This component can be attached to any collider. You can specify a roll-off to fade-in/out of the reverb. The reverb parameters will be defined in the Wwise project, by the sound designer. All **AkGameObj** that are "environment"-aware will receive a send value when entering the attached collider.

- **inspector AkEnvironment  AkEnvironmentPortal**
- Integrating Environments and Game-defined Auxiliary Sends (Note: This is described in the Wwise SDK documentation.)
- **AK::SoundEngine::SetGameObjectAuxSendValues** (Note: This is described in the Wwise SDK documentation.)
AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm

AkEnvironment::AkEnvironment_CompareByPriority
The selection algorithm is as follow:

1. Environments have priorities.
2. Environments have a "Default" flag. This flag effectively says that this environment will be bumped out if any other is present.
3. Environments have an "Exclude Other" flag. This flag will tell that this env is not overlappable with others. So, only one (the highest priority) should be selected.
AkEnvironmentPortal

Use this component to define an area that straddles two different AkEnvironments zones and allow mixing between both zones.

inspector AkEnvironment  AkEnvironmentPortal
float **GetAuxSendValueForPosition** (Vector3 in_position, int index)
The axis used to find the contribution of each environment.
| Vector3 | axis = new Vector3(1,0,0) |
Use this component to define an area that straddles two different AkEnvironments zones and allow mixing between both zones.

inspector AkEnvironment AkEnvironmentPortal

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AkEvent

Helper class that knows a Wwise Event and when to trigger it in Unity. As of 2017.2.0, the AkEvent inspector has buttons for play/stop, play multiple, stop multiple, and stop all. Play/Stop will play or stop the event such that it can be previewed both in edit mode and play mode. When multiple objects are selected, Play Multiple and Stop Multiple will play or stop the associated AkEvent for each object. ...

AkEvent

AkEvent

AkAmbient
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td><code>eventID = 0</code> ID of the Event as found in the WwiseID.cs file.</td>
</tr>
<tr>
<td>GameObject</td>
<td><code>soundEmitterObject = null</code> Game object onto which the Event will be posted. By default, when empty, it is posted on the same object on which the component was added.</td>
</tr>
<tr>
<td>bool</td>
<td><code>enableActionOnEvent = false</code> Enables additional options to reuse existing events. Use it to transform a Play event into a Stop event without having to define one in the Wwise Project.</td>
</tr>
<tr>
<td>AkActionOnEventType</td>
<td><code>actionOnEventType = AkActionOnEventType.AkActionOnEventType_Stop</code> Replacement action. See AK::SoundEngine::ExecuteEventOnAction().</td>
</tr>
<tr>
<td>AkCurveInterpolation</td>
<td><code>curveInterpolation = AkCurveInterpolation.AkCurveInterpolation_Linear</code> Fade curve to use with the new Action. See AK::SoundEngine::ExecuteEventOnAction().</td>
</tr>
<tr>
<td>float</td>
<td><code>transitionDuration = 0.0f</code> Duration of the fade. See AK::SoundEngine::ExecuteEventOnAction().</td>
</tr>
<tr>
<td>const int</td>
<td><code>MAX_NB_TRIGGERS = 32</code> Since our mask is a 32 bits integer, we can’t have more than 32 triggers.</td>
</tr>
<tr>
<td>List&lt; int &gt;</td>
<td><code>triggerList = new List&lt;int&gt;() { START_TRIGGER_ID }</code> List containing the enabled triggers.</td>
</tr>
<tr>
<td>bool</td>
<td><code>useOtherObject = false</code> This property is usefull only when used with colliders. When enabled, the target of the action</td>
</tr>
</tbody>
</table>
will be the other colliding object. When disabled, will be the current object.
<table>
<thead>
<tr>
<th>static Dictionary&lt; uint, string &gt;</th>
<th><code>triggerTypes = AkTriggerBase.GetAllDerivedTypes ();</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Will contain the types of all the triggers derived from <code>AkTriggerBase</code> at runtime.</td>
</tr>
</tbody>
</table>
Helper class that knows a Wwise Event and when to trigger it in Unity. As of 2017.2.0, the `AkEvent` inspector has buttons for play/stop, play multiple, stop multiple, and stop all. Play/Stop will play or stop the event such that it can be previewed both in edit mode and play mode. When multiple objects are selected, Play Multiple and Stop Multiple will play or stop the associated `AkEvent` for each object.

- **Edit Mode Support**
- **inspector AkAmbient**
- **Integration Details - Events** (Note: This is described in the Wwise SDK documentation.)
AkEventCallbackMsg

Event callback information. Event callback functions can receive this structure as a parameter. ...
<table>
<thead>
<tr>
<th>GameObject</th>
<th>sender</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AkSoundEngine.PostEvent callback flags. See the AkCallbackType enumeration for a list of all callbacks.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AkCallbackInfo</th>
<th>info</th>
</tr>
</thead>
<tbody>
<tr>
<td>GameObject from whom the callback function was called.</td>
<td></td>
</tr>
</tbody>
</table>
Event callback information. Event callback functions can receive this structure as a parameter.
AkGameObj

This component represents a sound object in your scene tracking its position and other game syncs such as Switches, RTPC and environment values. You can add this to any object that will emit sound, and it will be added to any object that an AkAudioListener is attached to. Note that if it is not present, Wwise will add it automatically, with the default values, to any Unity Game Object that is passed to Wwise. ...
<table>
<thead>
<tr>
<th>Type</th>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bool</td>
<td><strong>AddListener</strong> <em>(AkAudioListener listener)</em></td>
<td>Adds an AkAudioListener to the container of listeners listening to this gameobject.</td>
</tr>
<tr>
<td>bool</td>
<td><strong>RemoveListener</strong> <em>(AkAudioListener listener)</em></td>
<td>Removes an AkAudioListener from the container of listeners listening to this gameobject.</td>
</tr>
<tr>
<td>virtual Vector3</td>
<td><strong>GetPosition</strong> ()</td>
<td></td>
</tr>
<tr>
<td>virtual Vector3</td>
<td><strong>GetForward</strong> ()</td>
<td></td>
</tr>
<tr>
<td>virtual Vector3</td>
<td><strong>GetUpward</strong> ()</td>
<td></td>
</tr>
<tr>
<td>AkGameObjPositionOffsetData</td>
<td>m_positionOffsetData = null</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When not set to null, the position will be offset relative to the Game Object position by the Position Offset.</td>
<td></td>
</tr>
<tr>
<td>bool</td>
<td>isEnvironmentAware = true</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is this object affected by Environment changes? Set to false if not affected in order to save some useless calls. Default is true.</td>
<td></td>
</tr>
</tbody>
</table>
This component represents a sound object in your scene tracking its position and other game syncs such as Switches, RTPC and environment values. You can add this to any object that will emit sound, and it will be added to any object that an AkAudioListener is attached to. Note that if it is not present, Wwise will add it automatically, with the default values, to any Unity Game Object that is passed to Wwise.

- **Integration Details - Game Objects** (Note: This is described in the Wwise SDK documentation.)
- **Integration Details - Events** (Note: This is described in the Wwise SDK documentation.)
- **Integrating Listeners** (Note: This is described in the Wwise SDK documentation.)
- **Integration Details - Switches** (Note: This is described in the Wwise SDK documentation.)
- **Integration Details - States** (Note: This is described in the Wwise SDK documentation.)
- **Integration Details - Environments and Game-defined Auxiliary Sends** (Note: This is described in the Wwise SDK documentation.)
AkInitializer
<table>
<thead>
<tr>
<th>Type</th>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>string</td>
<td><strong>basePath</strong> = AkSoundEngineController.s_DefaultBasePath</td>
<td>Path for the soundbanks. This must contain one subfolder per platform, with the same as in the Wwise project.</td>
</tr>
<tr>
<td>string</td>
<td><strong>language</strong> = AkSoundEngineController.s_Language</td>
<td>Language sub-folder.</td>
</tr>
<tr>
<td>int</td>
<td><strong>defaultPoolSize</strong> = AkSoundEngineController.s_DefaultPoolSize</td>
<td>Default Pool size. This contains the meta data for your project. Default size is 4 MB, but you should adjust for your needs.</td>
</tr>
<tr>
<td>int</td>
<td><strong>lowerPoolSize</strong> = AkSoundEngineController.s_LowerPoolSize</td>
<td>Lower Pool size. This contains the audio processing buffers and DSP data. Default size is 2 MB, but you should adjust for your needs.</td>
</tr>
<tr>
<td>int</td>
<td><strong>streamingPoolSize</strong> = AkSoundEngineController.s_StreammingPoolSize</td>
<td>Streaming Pool size. This contains the streaming buffers. Default size is 1 MB, but you should adjust for your needs.</td>
</tr>
<tr>
<td>int</td>
<td><strong>preparePoolSize</strong> = AkSoundEngineController.s_PreparePoolSize</td>
<td>Prepare Pool size. This contains the banks loaded using PrepareBank (Banks decoded on load use this). Default size is 0 MB, but you should adjust for your needs.</td>
</tr>
<tr>
<td>float</td>
<td><strong>memoryCutoffThreshold</strong> = AkSoundEngineController.s_MemoryCutoffThreshold</td>
<td>This setting will trigger the killing of sounds when the memory is reaching 95% of capacity. Lowest priority sounds are killed.</td>
</tr>
<tr>
<td>int</td>
<td><strong>monitorPoolSize</strong> = AkSoundEngineController.s_MonitorPoolSize</td>
<td>Monitor Pool size. Size of the monitoring pool, in bytes. This parameter is not used in Release build.</td>
</tr>
<tr>
<td>Type</td>
<td>Variable Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>int</td>
<td><code>monitorQueuePoolSize = AkSoundEngineController.s_MonitorQueuePoolSize</code></td>
<td>Monitor Queue Pool size. Size of the monitoring queue pool, in bytes. This parameter is not used in Release builds.</td>
</tr>
<tr>
<td>int</td>
<td><code>callbackManagerBufferSize = AkSoundEngineController.s_CallbackManagerBufferSize</code></td>
<td>CallbackManager buffer size. The size of the buffer used per-frame to transfer callback data. Default size is 4 KB, you should increase this, if required.</td>
</tr>
<tr>
<td>int</td>
<td><code>spatialAudioPoolSize = AkSoundEngineController.s_SpatialAudioPoolSize</code></td>
<td>Spatial Audio Lower Pool size. Default size is 4 MB, should adjust for your needs.</td>
</tr>
<tr>
<td>uint</td>
<td><code>maxSoundPropagationDepth = AkSoundEngine.AK_MAX_SOUND_PROPAGATION_DEPTH</code></td>
<td>Spatial Audio Max Sound Propagation Depth. Maximum number of rooms that sound can propagate through; must be less than or equal to AK_MAX_SOUND_PROPAGATION_DEPTH.</td>
</tr>
<tr>
<td>AkDiffractionFlags</td>
<td><code>diffractionFlags = AkDiffractionFlags.DefaultDiffractionFlags</code></td>
<td>Enable or disable specific diffraction features. See AkDiffractionFlags.</td>
</tr>
<tr>
<td>bool</td>
<td><code>engineLogging = AkSoundEngineController.s_EngineLogging</code></td>
<td>Enable Wwise engine logging. Option to turn on/off the logging of the Wwise engine.</td>
</tr>
</tbody>
</table>
This script deals with initialization, and frame updates of the Wwise audio engine. It is marked as `DontDestroyOnLoad` so it stays active for the life of the game, not only one scene. You can, and probably should, modify this script to change the initialization parameters for the sound engine. A few are already exposed in the property inspector. It must be present on one Game Object at the beginning of the game to initialize the audio properly. It must be executed BEFORE any other MonoBehaviors that use `AkSoundEngine`.

- **Initialize the Different Modules of the Sound Engine** (Note: This is described in the Wwise SDK documentation.)
- `AK::SoundEngine::Init()` (Note: This is described in the Wwise SDK documentation.)
- `AK::SoundEngine::Term()` (Note: This is described in the Wwise SDK documentation.)
- `AkCallbackManager`
AkMemBankLoader
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>void LoadNonLocalizedBank(string in_bankFilename)</code></td>
<td>Load a sound bank from WWW object.</td>
</tr>
<tr>
<td><code>void LoadLocalizedBank( string in_bankFilename)</code></td>
<td>Load a language-specific bank from WWW object.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Variable Name</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>string</td>
<td><code>bankName</code></td>
</tr>
<tr>
<td>bool</td>
<td><code>isLocalizedBank</code></td>
</tr>
</tbody>
</table>
This class is an example of how to load banks in Wwise, if the bank data was preloaded in memory. This would be useful for situations where you use the WWW class.
AkRoom

An AkRoom is an enclosed environment that can only communicate to the outside/other rooms with AkRoomPortals. ...
ulong GetID ()

Access the room's ID.
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>float</td>
<td>reverbLevel</td>
<td>1</td>
</tr>
<tr>
<td>float</td>
<td>wallOcclusion</td>
<td>1</td>
</tr>
<tr>
<td>int</td>
<td>priority</td>
<td>0</td>
</tr>
</tbody>
</table>

The reverb control value for the send to the reverb aux bus.
Occlusion level modeling transmission through walls.
An **AkRoom** is an enclosed environment that can only communicate to the outside/other rooms with AkRoomPortals.
AkRoomPortal

An **AkRoomPortal** can connect two **AkRoom** components together. ... 

AkUnityEventHandler
<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ulong GetID ()</td>
<td>Access the portal's ID.</td>
</tr>
<tr>
<td>override void</td>
<td><strong>HandleEvent</strong> (GameObject in_gameObject)</td>
</tr>
<tr>
<td></td>
<td>Opens the portal on trigger event.</td>
</tr>
<tr>
<td>void</td>
<td><strong>ClosePortal</strong> (GameObject in_gameObject)</td>
</tr>
<tr>
<td></td>
<td>Closes the portal on trigger event.</td>
</tr>
</tbody>
</table>
const int **MAX_ROOMS_PER_PORTAL** = 2  
AkRoomPortals can only connect a maximum of 2 rooms.

AkRoom[]   **rooms** = new AkRoom[**MAX_ROOMS_PER_PORTAL**]  

const int **MAX_NB_TRIGGERS** = 32  
Since our mask is a 32 bits integer, we can't have more than 32 triggers.

List< int > **triggerList** = new List<int>() { START_TRIGGER_ID }  
List containing the enabled triggers.

bool **useOtherObject** = false  
This property is usefull only when used with colliders. When enabled, the target of the action will be the other colliding object. When disabled, it will be the current object.
<table>
<thead>
<tr>
<th>static Dictionary&lt; uint, string &gt;</th>
<th><strong>triggerTypes</strong> = AkTriggerBase.GetAllDerivedTypes ()</th>
</tr>
</thead>
<tbody>
<tr>
<td>Will contain the types of all the triggers derived from <strong>AkTriggerBase</strong> at runtime.</td>
<td></td>
</tr>
</tbody>
</table>
An AkRoomPortal can connect two AkRoom components together.
AkRoomPortalObstruction

Obstructs/Occludes the spatial audio portal of the current game object from the spatial audio listener if at least one object is between them. ...

AkObstructionOcclusion
<table>
<thead>
<tr>
<th><strong>LayerMask</strong></th>
<th><strong>LayerMask = -1</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates which layers act as obstructor/occluders.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>float</strong></th>
<th><strong>refreshInterval = 1</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The number of seconds between obstruction/occlusion checks.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>float</strong></th>
<th><strong>fadeTime = 0.5f</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The number of seconds for fade ins and fade outs.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>float</strong></th>
<th><strong>maxDistance = -1.0f</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The maximum distance at which to perform obstruction/occlusion. A negative value will be interpreted as infinite distance.</td>
<td></td>
</tr>
</tbody>
</table>
Obstructs/Occludes the spatial audio portal of the current game object from the spatial audio listener if at least one object is between them.

If no spatial audio listener has been registered, there will be no obstruction.
**AkSpatialAudioEmitter**

Add this script on the GameObject which represents an emitter that uses the Spatial Audio API. ...

AkSpatialAudioBase
<table>
<thead>
<tr>
<th><strong>AK.Wwise.AuxBus</strong></th>
<th><strong>reflectAuxBus</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Auxiliary Bus with a Reflect plug-in Effect applied.</td>
<td></td>
</tr>
</tbody>
</table>

- **uint** *(reflectionsOrder = 1)*
- **float** *(reflectionsAuxBusGain = 1)*
  - The gain [0, 1] applied to the reflect auxiliary bus.
- **float** *(reflectionMaxPathLength = 1000)*
  - A heuristic to stop the computation of reflections. Should be no longer (and possibly shorter for less CPU usage) than the maximum attenuation of the sound emitter.
- **float** *(roomReverbAuxBusGain = 1)*
  - Send gain (0.f-1.f) that is applied when sending to the aux bus associated with the room that the emitter is in.
Add this script on the GameObject which represents an emitter that uses the Spatial Audio API.
AkSpatialAudioListener

Add this script on the game object that represent a listener. This is normally added to the Camera object or the Player object, but can be added to any game object when implementing 3D busses. isDefaultListener determines whether the game object will be considered a default listener - a listener that automatically listens to all game objects that do not have listeners attached to their AkGameObjListenerList's. ...

AkSpatialAudioBase
Add this script on the game object that represent a listener. This is normally added to the Camera object or the Player object, but can be added to any game object when implementing 3D busses. isDefaultListener determines whether the game object will be considered a default listener - a listener that automatically listens to all game objects that do not have listeners attached to their AkGameObjListenerList's.

- Integrating Listeners (Note: This is described in the Wwise SDK documentation.)
AkState

This will call AkSoundEngine.SetState() whenever the selected Unity event is triggered. For example this component could be set on a Unity collider to trigger when an object enters it. ...

AkUnityEventHandler
<table>
<thead>
<tr>
<th><strong>int</strong></th>
<th><strong>groupID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>State Group ID, as defined in WwiseID.cs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>int</strong></th>
<th><strong>valueID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>State Value ID, as defined in WwiseID.cs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>const int</strong></th>
<th><strong>MAX_NB_TRIGGERS = 32</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Since our mask is a 32 bits integer, we can't have more than 32 triggers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>List&lt; int &gt;</strong></th>
<th><strong>triggerList = new List&lt;int&gt;() { START_TRIGGER_ID }</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List containing the enabled triggers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>bool</strong></th>
<th><strong>useOtherObject = false</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This property is usefull only when used with colliders. When enabled, the target of the action will be the other colliding object. When disabled, it will be the current object.</td>
</tr>
<tr>
<td>static Dictionary&lt; uint, string &gt;</td>
<td><strong>triggerTypes</strong> = AkTriggerBase.GetAllDerivedTypes ()</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Will contain the types of all the triggers derived from <strong>AkTriggerBase</strong> at runtime.</td>
</tr>
</tbody>
</table>
This will call AkSoundEngine.SetState() whenever the selected Unity event is triggered. For example this component could be set on a Unity collider to trigger when an object enters it.

- Integration Details - States (Note: This is described in the Wwise SDK documentation.)
AkSurfaceReflector

This component will convert the triangles of the GameObject's geometry into sound reflective surfaces. ...
<table>
<thead>
<tr>
<th>static void</th>
<th><strong>AddGeometrySet</strong> <em>(AK.Wwise.AcousticTexture acousticTexture, MeshFilter meshFilter)</em></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sends the mesh filter's triangles and their acoustic texture to Spatial Audio.</td>
</tr>
<tr>
<td>static void</td>
<td><strong>RemoveGeometrySet</strong> <em>(MeshFilter meshFilter)</em></td>
</tr>
<tr>
<td></td>
<td>Remove the corresponding mesh filter's geometry from Spatial Audio.</td>
</tr>
<tr>
<td><strong>AK.Wwise.AcousticTexture</strong></td>
<td><strong>AcousticTexture</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>All triangles of the component's mesh will be applied with this texture. The texture will change the filter parameters of the sound reflected from this component.</td>
<td></td>
</tr>
</tbody>
</table>
This component will convert the triangles of the GameObject's geometry into sound reflective surfaces.

This component requires a Mesh Filter component. The triangles of the mesh will be sent to the Spatial Audio wrapper by calling SpatialAudio::AddGeometrySet(). The triangles will reflect the sound emitted from AkSpatialAudioEmitter components.
AkSwitch

This will call AkSoundEngine.SetSwitch() whenever the selected Unity event is triggered. For example this component could be set on a Unity collider to trigger when an object enters it. ...

AkUnityEventHandler
<table>
<thead>
<tr>
<th>int</th>
<th><strong>groupId</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switch Group ID, as defined in WwiseID.cs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>int</th>
<th><strong>valueId</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switch Value ID, as defined in WwiseID.cs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>const int</th>
<th><strong>MAX_NB_TRIGGERS</strong> = 32</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Since our mask is a 32 bits integer, we can't have more than 32 triggers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>List&lt;int&gt;</th>
<th><strong>triggerList</strong> = new List&lt;int&gt;() { START_TRIGGER_ID }</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List containing the enabled triggers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>bool</th>
<th><strong>useOtherObject</strong> = false</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This property is usefull only when used with colliders. When enabled, the target of the action will be the other colliding object. When disabled, it will be the current object.</td>
</tr>
<tr>
<td>static Dictionary&lt; uint, string &gt;</td>
<td><strong>triggerTypes</strong> = AkTriggerBase.GetAllDerivedTypes ();</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Will contain the types of all the triggers derived from <strong>AkTriggerBase</strong> at runtime.</td>
<td></td>
</tr>
</tbody>
</table>
This will call `AkSoundEngine.SetSwitch()` whenever the selected Unity event is triggered. For example this component could be set on a Unity collider to trigger when an object enters it.

- Integration Details - Switches (Note: This is described in the Wwise SDK documentation.)
Ak Terminator
This script deals with termination of the Wwise audio engine. It must be present on one Game Object that gets destroyed last in the game. It must be executed AFTER any other monoBehaviors that use AkSoundEngine.

- **Terminate the Different Modules of the Sound Engine** (Note: This is described in the Wwise SDK documentation.)
  - `AK::SoundEngine::Term()` (Note: This is described in the Wwise SDK documentation.)
AkTriggerBase

AkTriggerCollisionEnter AkTriggerCollisionExit AkTriggerDisable
AkTriggerEnable AkTriggerEnter AkTriggerExit
AkTriggerMouseDown AkTriggerMouseEnter AkTriggerMouseExit
AkTriggerMouseUp.
<table>
<thead>
<tr>
<th>Delegate</th>
<th>Trigger (GameObject in_gameObject)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delegate declaration for all Wwise Triggers.</td>
</tr>
<tr>
<td>Trigger</td>
<td><code>triggerDelegate = null</code></td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------</td>
</tr>
<tr>
<td></td>
<td>All components reacting to the trigger will be registered in this delegate.</td>
</tr>
</tbody>
</table>
Base class for the generic triggering mechanism for Wwise Integration. All Wwise components will use this mechanism to drive their behavior. Derive from this class to add your own triggering condition, as described in Wwise Events Trigger.
- AK::Wwise::BaseType
  - AK::Wwise::AcousticTexture
  - AK::Wwise::AuxBus
  - AK::Wwise::Bank
  - AK::Wwise::BaseGroupType
    - AK::Wwise::State
    - AK::Wwise::Switch
  - AK::Wwise::Event
  - AK::Wwise::RTPC
  - AK::Wwise::Trigger
- AK::Wwise::CallbackFlags
- AkAudioListener
- AkBank
- AkCallbackManager
- AkEmitterObstructionOcclusion
- AkEnvironment
- AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
- AkEnvironmentPortal
- AkEvent
  - AkAmbient
- AkEventCallbackMsg
- AkGameObj
- AkInitializer
- AkMemBankLoader
- AkRoom
- AkRoomPortal
- AkRoomPortalObstruction
- AkSpatialAudioEmitter
- AkSpatialAudioListener
- AkState
- AkSurfaceReflector
- AkSwitch
- AkTerminator
- AkTriggerBase
- a -

- AcousticTexture : **AkSurfaceReflector**
- actionOnEventType : **AkEvent**
- AddGeometrySet() : **AkSurfaceReflector**
- AddListener() : **AkGameObj**
- axis : **AkEnvironmentPortal**

- b -

- bankName : **AkBank, AkMemBankLoader**
- basePath : **AkInitializer**

- c -

- callbackManagerBufferSize : **AkInitializer**
- ClosePortal() : **AkRoomPortal**
- curveInterpolation : **AkEvent**

- d -

- decodeBank : **AkBank**
- defaultPoolSize : **AkInitializer**
- diffractionFlags : **AkInitializer**

- e -

- enableActionOnEvent : **AkEvent**
- engineLogging : **AkInitializer**
- eventID : **AkEvent**
- ExecuteAction() : **AK::Wwise::Event**

- **g** -
  
  - GetAuxSendValueForPosition() : **AkEnvironmentPortal**
  - GetForward() : **AkGameObj**
  - GetID() : **AkRoomPortal, AkRoom**
  - GetPosition() : **AkGameObj**
  - GetUpward() : **AkGameObj**
  - groupID : **AkSwitch, AkState**

- **h** -
  
  - HandleEvent() : **AkBank, AkRoomPortal**

- **i** -
  
  - info : **AkEventCallbackMsg**
  - isEnvironmentAware : **AkGameObj**
  - isLocalizedBank : **AkMemBankLoader**

- **l** -
  
  - language : **AkInitializer**
  - loadAsynchronous : **AkBank**
  - LoadLocalizedBank() : **AkMemBankLoader**
  - LoadNonLocalizedBank() : **AkMemBankLoader**
  - lowerPoolSize : **AkInitializer**

- **m** -
  
  - m_positionOffsetData : **AkGameObj**
  - MAX_ROOMS_PER_PORTAL : **AkRoomPortal**
  - maxSoundPropagationDepth : **AkInitializer**
  - memoryCutoffThreshold : **AkInitializer**
  - monitorPoolSize : **AkInitializer**
  - monitorQueuePoolSize : **AkInitializer**
- p -

- Post() : \texttt{AK::Wwise::Event}
- PostCallbacks() : \texttt{AkCallbackManager}
- PostMIDI() : \texttt{AK::Wwise::Event}
- preparePoolSize : \texttt{AkInitializer}
- priority : \texttt{AkRoom}

- r -

- reflectAuxBus : \texttt{AkSpatialAudioEmitter}
- reflectionMaxPathLength : \texttt{AkSpatialAudioEmitter}
- reflectionsAuxBusGain : \texttt{AkSpatialAudioEmitter}
- reflectionsOrder : \texttt{AkSpatialAudioEmitter}
- RemoveGeometrySet() : \texttt{AkSurfaceReflector}
- RemoveListener() : \texttt{AkGameObj}
- reverbAuxBus : \texttt{AkRoom}
- reverbLevel : \texttt{AkRoom}
- roomReverbAuxBusGain : \texttt{AkSpatialAudioEmitter}
- rooms : \texttt{AkRoomPortal}

- s -

- saveDecodedBank : \texttt{AkBank}
- sender : \texttt{AkEventCallbackMsg}
- SetBGMCallback() : \texttt{AkCallbackManager}
- SetMonitoringCallback() : \texttt{AkCallbackManager}
- soundEmitterObject : \texttt{AkEvent}
- spatialAudioPoolSize : \texttt{AkInitializer}
- StopMIDI() : \texttt{AK::Wwise::Event}
- streamingPoolSize : \texttt{AkInitializer}

- t -

- transitionDuration : \texttt{AkEvent}
- Trigger() : \texttt{AkTriggerBase}
- triggerDelegate : \texttt{AkTriggerBase}
- $u$ -
  
  - UnloadBank() : **AkBank**
  - unloadTriggerList : **AkBank**

- $v$ -
  
  - valueID : **AkState**, **AkSwitch**

- $w$ -
  
  - wallOcclusion : **AkRoom**
**AK::Wwise::Event**

```cpp
uint AK::Wwise::Event::Post ( GameObject gameObject )
```

Posts this Event on a GameObject.

- `gameObject` The GameObject

Returns the playing ID.
## AK::Wwise::Event

### void AK::Wwise::Event::PostMIDI ( GameObject

| PostMIDI
| PostMIDI
| StopMIDI
| StopMIDI |

Posts MIDI Events on this Event associated with a GameObject.

- **gameObject**: The GameObject
- **array**: The array of AkMIDIPost that are posted.
string AkInitializer::basePath = AkSoundEngineController.s_DefaultBasePath

Path for the soundbanks. This must contain one sub folder per platform, with the same as in the Wwise project.
static void AkCallbackManager::SetMonitoringCallback

Call this to set a function to call whenever Wwise prints a message (warnings or errors).
AkMemBankLoader

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bankName</td>
<td></td>
</tr>
<tr>
<td>isLocalizedBank</td>
<td></td>
</tr>
<tr>
<td>LoadLocalizedBank</td>
<td></td>
</tr>
<tr>
<td>LoadNonLocalizedBank</td>
<td></td>
</tr>
</tbody>
</table>

void AkMemBankLoader::LoadNonLocalizedBank

Load a sound bank from WWW object.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
static void AkCallbackManager::SetBGMCallback

Call this to set a iOS callback interruption function.

PostCallbacks
SetBGMCallback
SetMonitoringCallback
AcousticTexture (AK::Wwise)

AkAmbient

AkAudioListener

AkBank

AkCallbackManager

AkEmitterObstructionOcclusion

AkEnvironment

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
### AkCallbackManager

<table>
<thead>
<tr>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostCallbacks</td>
</tr>
<tr>
<td>SetBGMCallback</td>
</tr>
<tr>
<td>SetMonitoringCallback</td>
</tr>
</tbody>
</table>

**static int AkCallbackManager::PostCallbacks**

This function dispatches all the accumulated callbacks from the sound engine. It must be called regularly. By default this is called in AkInitializer.cs.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by **doxygen** 1.6.3
AK::Wwise::Bank

AK::Wwise::Bank

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AK::Wwise::BaseGroupType

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
## AK::Wwise::Event

**ExecuteAction**(GameObject GameObject, AkActionOnEventType actionOnEventType, int transitionDuration, AkCurveInterpolation curveInterpolation)

**Post**(GameObject GameObject)

**Post**(GameObject GameObject, CallbackFlags flags, AkCallbackManager.EventCallback callback, object cookie=null)

**Post**(GameObject GameObject, uint flags, AkCallbackManager.EventCallback callback, object cookie=null)

**PostMIDI**(GameObject GameObject, AkMIDIPostArray array)

**PostMIDI**(GameObject GameObject, AkMIDIPostArray array, int count)

**StopMIDI**(GameObject GameObject)

**StopMIDI**()
AK::Wwise::Event

```cpp
uint AK::Wwise::Event::Post ( GameObject CallbackFlags AkCallbackManager object )
```

Posts this Event on a GameObject.

```
gameObject The GameObject
flags
callback
cookie Optional cookie received by the call
```

Returns the playing ID.
uint AK::Wwise::Event::Post ( GameObject
uint
AkCallbackManager::
object
)

Posts this Event on a GameObject.

: 

gameObject The GameObject
flags
callback
cookie Optional cookie received by the call

: 

Returns the playing ID.
AK::Wwise::Event

void AK::Wwise::Event::ExecuteAction ( GameObject *gameObject, AkActionOnEventType actionOnEventType, int transitionDuration, AkCurveInterpolation curveInterpolation )

Executes various actions on this event associated with the given GameObject:

- **gameObject**: The GameObject
- **actionOnEventType**: The event type of the action
- **transitionDuration**: The duration of the transition
- **curveInterpolation**: The curve interpolation method
void AK::Wwise::Event::PostMIDI ( GameObject * gameObject, AkMIDIPostArray array, int count )

Posts MIDI Events on this Event associated with a GameObject:

gameObject  The GameObject
array       The array of AkMIDIPost that are posted.
count       The number of elements from the array that are posted.
void AK::Wwise::Event::StopMIDI (GameObject &gameObject)

Stops MIDI Events on this Event associated with a GameObject:

  gameObject The GameObject
void AK::Wwise::Event::StopMIDI()

Stops all MIDI Events on this Event.
## AkAmbient

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>actionOnEventType</td>
<td>AkEvent</td>
</tr>
<tr>
<td>curveInterpolation</td>
<td>AkEvent</td>
</tr>
<tr>
<td>enableActionOnEvent</td>
<td>AkEvent</td>
</tr>
<tr>
<td>eventID</td>
<td>AkEvent</td>
</tr>
<tr>
<td>soundEmitterObject</td>
<td>AkEvent</td>
</tr>
<tr>
<td>transitionDuration</td>
<td>AkEvent</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>AkEvent</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>actionOnEventType</strong></td>
</tr>
<tr>
<td><strong>curveInterpolation</strong></td>
</tr>
<tr>
<td><strong>enableActionOnEvent</strong></td>
</tr>
<tr>
<td><strong>eventID</strong></td>
</tr>
<tr>
<td><strong>soundEmitterObject</strong></td>
</tr>
<tr>
<td><strong>transitionDuration</strong></td>
</tr>
</tbody>
</table>

| **int AkEvent::eventID = 0** |
| ID of the Event as found in the WwiseID.cs file. |

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AkEvent

**GameObject AkEvent::soundEmitterObject**

Game object onto which the Event will be posted. By default, when empty, it is posted on the same object on which the component was added.
**AkEvent**

- **actionOnEventType**
- **curveInterpolation**
- **enableActionOnEvent**
- **eventID**
- **soundEmitterObject**
- **transitionDuration**

**bool AkEvent::enableActionOnEvent = false**

Enables additional options to reuse existing events. Use it to transform a Play event into a Stop event without having to define one in the Wwise Project.
AkEvent

<table>
<thead>
<tr>
<th>actionOnEventType</th>
<th>eventID</th>
<th>soundEmitterObject</th>
<th>transitionDuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>curveInterpolation</td>
<td>enableActionOnEvent</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Replacement action. See AK::SoundEngine::IAction::OnEvent().

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>Action On Event Type</th>
<th>curveInterpolation</th>
<th>Enable Action On Event</th>
<th>event ID</th>
<th>sound Emitter Object</th>
<th>transition Duration</th>
</tr>
</thead>
</table>

AkCurveInterpolation AkEvent::curveInterpolation

Fade curve to use with the new Action. See AK::SoundEngine::ExecuteEventOnAction().
**AkEvent**

- `actionOnEventType`
- `curveInterpolation`
- `enableActionOnEvent`
- `eventID`
- `soundEmitterObject`
- `transitionDuration`

**`float AkEvent::transitionDuration = 0.0f`**

Duration of the fade. See `AK::SoundEngine::ExecuteEventOnAction()`.
const int AkUnityEventHandler::MAX_NB_TRIGGERS = 32;

Since our mask is a 32 bits integer, we can't have more than
<table>
<thead>
<tr>
<th>groupID</th>
<th>valueID</th>
</tr>
</thead>
<tbody>
<tr>
<td>List&lt;int&gt; AkUnityEventHandler::triggerList = new List&lt;int&gt;(){START_TRIGGER_ID}</td>
<td></td>
</tr>
</tbody>
</table>

List containing the enabled triggers.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
This property is useful only when used with colliders. When enabled, the target of the action will be the other colliding object. When disabled, it will be the current object.
Dictionary<uint, string> AkUnityEventHandler::triggerTypes

Will contain the types of all the triggers derived from AkTriggerBase.
# AkBank

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bankName</td>
<td>AkBank</td>
</tr>
<tr>
<td>decodeBank</td>
<td>AkBank</td>
</tr>
<tr>
<td>HandleEvent</td>
<td>GameObject in_gameObject AkBank [inline]</td>
</tr>
<tr>
<td>loadAsynchronous</td>
<td>AkBank</td>
</tr>
<tr>
<td>saveDecodedBank</td>
<td>AkBank</td>
</tr>
<tr>
<td>UnloadBank</td>
<td>GameObject in_gameObject AkBank [inline]</td>
</tr>
<tr>
<td>unloadTriggerList</td>
<td>AkBank</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by [doxygen](#) 1.6.3
override void AkBank::HandleEvent ( GameObject )

Loads the SoundBank.
void AkBank::UnloadBank (GameObject in_

Unloads a SoundBank.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AkBank

string AkBank::bankName = ""

Name of the SoundBank, as specified in the Wwise project.
<table>
<thead>
<tr>
<th>bankName</th>
<th>decodeBank</th>
<th>HandleEvent</th>
<th>loadAsynchronous</th>
<th>saveDecodedBank</th>
<th>UnloadBank</th>
<th>unloadTriggerList</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bool AkBank::loadAsynchronous = false</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Check this to load the SoundBank in the background. Be careful, if Events are triggered and the SoundBank hasn't finished loading, you'll have "Event not found" errors.
bool AkBank::decodeBank = false

Decode this SoundBank upon load.
<table>
<thead>
<tr>
<th>bankName</th>
<th>decodeBank</th>
<th>HandleEvent</th>
<th>loadAsynchronous</th>
<th>saveDecodedBank</th>
<th>UnloadBank</th>
<th>unloadTriggerList</th>
</tr>
</thead>
</table>

```cpp
bool AkBank::saveDecodedBank = false
```

Save the decoded SoundBank to disk for faster loads in the future.
List<int> AkBank::unloadTriggerList = new List<int>()

Reserved.
## AkCallbackManager

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostCallbacks()</td>
<td></td>
</tr>
<tr>
<td>SetBGMCallback(BGMCallback in_CB, object in_cookie)</td>
<td></td>
</tr>
<tr>
<td>SetMonitoringCallback(AkMonitorErrorLevel in_Level, MonitoringCallback in_CB)</td>
<td></td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by [doxygen](https://github.com/doxygen/doxygen) 1.6.3
AkRoomPortalObstruction

**LayerMask** `AkObstructionOcclusion::LayerMask = -1 [inherited]`

- Indicates which layers act as obstructers/occluders.
The number of seconds between obstruction/occlusion checks.

float AkObstructionOcclusion::refreshInterval = 1 [inherited]
float AkObstructionOcclusion::fadeTime = 0.5f [inherited]

The number of seconds for fade ins and fade outs.
The maximum distance at which to perform obstruction/occlusion. A negative value will be interpreted as infinite distance.
<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>GetAuxSendValueForPosition</code></td>
<td>(Vector3 in_position, int index)</td>
</tr>
</tbody>
</table>
float AkEnvironmentPortal::GetAuxSendValueForPosition

The axis used to find the contribution...
The array is already sorted by position. The first environment is on the negative side of the portal (opposite to the direction of the chosen axis). The second environment is on the positive side of the portal.
## AkEvent

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>actionOnEventType</td>
<td>AkEvent</td>
</tr>
<tr>
<td>curveInterpolation</td>
<td>AkEvent</td>
</tr>
<tr>
<td>enableActionOnEvent</td>
<td>AkEvent</td>
</tr>
<tr>
<td>eventID</td>
<td>AkEvent</td>
</tr>
<tr>
<td>soundEmitterObject</td>
<td>AkEvent</td>
</tr>
<tr>
<td>transitionDuration</td>
<td>AkEvent</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by [doxygen](https://www.doxygen.org) 1.6.3
AkEventCallbackMsg

info AkEventCallbackMsg
sender AkEventCallbackMsg

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by oxygen 1.6.3
AkEventCallbackMsg

GameObject AkEventCallbackMsg::sender

AkSoundEngine.PostEvent callback flags. See the AkCallbackType enumeration for a list of all callbacks.
AkEventCallbackMsg

<table>
<thead>
<tr>
<th>AkCallbackInfo AkEventCallbackMsg::info</th>
</tr>
</thead>
<tbody>
<tr>
<td>GameObject from whom the callback function was called.</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
## AkGameObj

<table>
<thead>
<tr>
<th>Method</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>addListener(AkAudioListener listener)</code></td>
<td>AkGameObj [inline]</td>
</tr>
<tr>
<td><code>GetForward()</code></td>
<td>AkGameObj [inline, virtual]</td>
</tr>
<tr>
<td><code>GetPosition()</code></td>
<td>AkGameObj [inline, virtual]</td>
</tr>
<tr>
<td><code>GetUpward()</code></td>
<td>AkGameObj [inline, virtual]</td>
</tr>
<tr>
<td><code>isEnvironmentAware</code></td>
<td>AkGameObj</td>
</tr>
<tr>
<td><code>m_positionOffsetData</code></td>
<td>AkGameObj</td>
</tr>
<tr>
<td><code>removeListener(AkAudioListener listener)</code></td>
<td>AkGameObj [inline]</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by [doxygen](https://www.stackoverflow.com) 1.6.3
### AkGameObj

**bool AkGameObj::AddListener (AkAudioListener*)**

Adds an **AkAudioListener** to the container of gameobject.

- : listener
  - Returns true if the listener was not previously, otherwise.

---

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by [doxygen](http://www.stackoverflow.com) 1.6.3
bool AkGameObj::RemoveListener (AkAudioListener &listener)

Removes an AkAudioListener from the container of listeners listening to this GameObject.

: listener

: Returns true if the listener was previously in the list, false otherwise.
### AkGameObj

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddListener</td>
<td></td>
</tr>
<tr>
<td>GetForward</td>
<td></td>
</tr>
<tr>
<td>GetPosition</td>
<td>virtual Vector3 AkGameObj::GetPosition ( ) Gets the position including the</td>
</tr>
<tr>
<td>GetUpward</td>
<td>position offset, if applyPositionOffset is enabled. User can also override</td>
</tr>
<tr>
<td>isEnvironmentAware</td>
<td>this method to calculate an arbitrary position.</td>
</tr>
<tr>
<td>m_positionOffsetData</td>
<td></td>
</tr>
<tr>
<td>RemoveListener</td>
<td></td>
</tr>
</tbody>
</table>

The position.
AkGameObj

virtual Vector3 AkGameObj::GetForward ()

Gets the orientation forward vector. User can method to calculate an arbitrary vector.

: The forward vector of orientation.
<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddListener</td>
</tr>
<tr>
<td>GetForward</td>
</tr>
<tr>
<td>GetPosition</td>
</tr>
<tr>
<td>GetUpward</td>
</tr>
<tr>
<td>isEnvironmentAware</td>
</tr>
<tr>
<td>m_positionOffsetData</td>
</tr>
<tr>
<td>RemoveListener</td>
</tr>
</tbody>
</table>

### virtual Vector3 AkGameObj::GetUpward()

Gets the orientation upward vector. User can method to calculate an arbitrary vector.

: The upward vector of orientation.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AkGameObj::AddListener</td>
<td>Add listener</td>
</tr>
<tr>
<td>AkGameObj::GetForward</td>
<td>Get forward position</td>
</tr>
<tr>
<td>AkGameObj::GetPosition</td>
<td>Get position position</td>
</tr>
<tr>
<td>AkGameObj::GetUpward</td>
<td>Get upward position</td>
</tr>
<tr>
<td>AkGameObj::isEnvironmentAware</td>
<td>Check if environment aware</td>
</tr>
<tr>
<td>AkGameObj::m_positionOffsetData</td>
<td>Position offset data</td>
</tr>
<tr>
<td>AkGameObj::RemoveListener</td>
<td>Remove listener</td>
</tr>
</tbody>
</table>

When not set to null, the position will be offset by the Position Offset.
AkGameObj

AddListener  
GetForward  
GetPosition  
GetUpward  
isEnvironmentAware  
m_positionOffsetData  
RemoveListener

bool AkGameObj::isEnvironmentAware = true

Is this object affected by Environment changes? Set to false if not affected in order to save some useless calls. Default is true.
<table>
<thead>
<tr>
<th>AkInitializer</th>
<th>AkInitializer</th>
</tr>
</thead>
<tbody>
<tr>
<td>basePath</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>callbackManagerBufferSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>defaultPoolSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>diffractionFlags</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>engineLogging</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>language</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>lowerPoolSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>maxSoundPropagationDepth</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>memoryCutoffThreshold</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>monitorPoolSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>monitorQueuePoolSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>preparePoolSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>spatialAudioPoolSize</td>
<td>AkInitializer</td>
</tr>
<tr>
<td>streamingPoolSize</td>
<td>AkInitializer</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
dependLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

string AkInitializer::language = AkS

Language sub-folder.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
globalLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int AkInitializer::defaultPoolSize = ...

Default Pool size. This contains the metadata for your audio project. Default size is 4 MB, but you should adjust for your needs.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
gineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int AkInitializer::lowerPoolSize = AkSoundEngineController.s_LowerPoolSize

Lower Pool size. This contains the audio processing buffers and DSP data. Default size is 2 MB, but you should adjust for your needs.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
genreLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int AkInitializer::streamingPoolSize

Streaming Pool size. This contains the streaming buffers. Default size is 1 MB, but you should adjust for your needs.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

```
int AkInitializer::preparePoolSize = AkSoundEngineController.s_PreparePoolSize;
```

Prepare Pool size. This contains the banks loaded using PrepareBank (Banks decoded on load use this). Default size is 0 MB.
# AkInitializer

- `basePath`
- `callbackManagerBufferSize`
- `defaultPoolSize`
- `diffractionFlags`
- `engineLogging`
- `language`
- `lowerPoolSize`
- `maxSoundPropagationDepth`
- `memoryCutoffThreshold`
- `monitorPoolSize`
- `monitorQueuePoolSize`
- `preparePoolSize`
- `spatialAudioPoolSize`
- `streamingPoolSize`

```cpp
float AkInitializer::memoryCutoffThreshold
```

This setting will trigger the killing of sounds when the memory is reaching 95% of capacity. Lowest priority sounds are killed.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractiOnFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int AkInitializer::monitorPoolSize = 

Monitor Pool size. Size of the monitoring pool, in bytes. This parameter is not used in Release build.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int AkInitializer::monitorQueuePoolSize

Monitor Queue Pool size. Size of the monitoring queue pool, in bytes. This parameter is not used in Release build.
CallbackManager buffer size. The size is 4 KB, but you should increase this, if required.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
gineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int AkInitializer::spatialAudioPoolSize

Spatial Audio Lower Pool size. Default

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

uint AkInitializer::maxSoundPropagationDepth

Spatial Audio Max Sound Propagation Depth.

Maximum number of rooms that sound can propagate through;

must be less than or equal to AK_MAX_SOUND_PROPAGATION_DEPTH.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

AkDiffractionFlags AkInitializer::diffractionFlags

Enable or disable specific diffraction features.
AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

bool AkInitializer::engineLogging = AkSoundEngineController.s_EngineLogging

Enable Wwise engine logging. Option to turn on/off the logging of the Wwise engine.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
## AkMemBankLoader

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bankName</td>
<td>AkMemBankLoader</td>
</tr>
<tr>
<td>isLocalizedBank</td>
<td>AkMemBankLoader</td>
</tr>
<tr>
<td>LoadLocalizedBank(string in_bankFilename)</td>
<td>AkMemBankLoader [inline]</td>
</tr>
<tr>
<td>LoadNonLocalizedBank(string in_bankFilename)</td>
<td>AkMemBankLoader [inline]</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>bankName</th>
<th>void AkMemBankLoader::LoadLocalizedBank</th>
</tr>
</thead>
<tbody>
<tr>
<td>isLocalizedBank</td>
<td>Load a language-specific bank from WWW</td>
</tr>
<tr>
<td>LoadLocalizedBank</td>
<td></td>
</tr>
<tr>
<td>LoadNonLocalizedBank</td>
<td></td>
</tr>
<tr>
<td>bankName</td>
<td>string AkMemBankLoader::bankName =</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>isLocalizedBank</td>
<td>Name of the bank to load.</td>
</tr>
<tr>
<td>LoadLocalizedBank</td>
<td></td>
</tr>
<tr>
<td>LoadNonLocalizedBank</td>
<td></td>
</tr>
</tbody>
</table>
bool AkMemBankLoader::isLocalizedBank

Is the bank localized (situated in the language specific folders).
## AkRoom

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetID()</td>
<td>AkRoom [inline]</td>
</tr>
<tr>
<td>priority</td>
<td>AkRoom</td>
</tr>
<tr>
<td>reverbAuxBus</td>
<td>AkRoom</td>
</tr>
<tr>
<td>reverbLevel</td>
<td>AkRoom</td>
</tr>
<tr>
<td>wallOcclusion</td>
<td>AkRoom</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
ulong AkRoom::GetID ( ) [inline]

Access the room's ID.
## AkRoom

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ak.Wwise.AuxBus</td>
<td>The reverb auxiliary bus.</td>
</tr>
<tr>
<td>AkRoom::reverbAuxBus</td>
<td>The reverb auxiliary bus.</td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>AkRoom Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>AkRoom::priority</td>
</tr>
<tr>
<td>AkRoom::reverbAuxBus</td>
</tr>
<tr>
<td>AkRoom::reverbLevel</td>
</tr>
<tr>
<td>AkRoom::wallOcclusion</td>
</tr>
</tbody>
</table>

**float AkRoom::reverbLevel = 1**

The reverb control value for the send to the reverb aux bus.
<table>
<thead>
<tr>
<th>getID</th>
<th>priority</th>
<th>reverbAuxBus</th>
<th>reverbLevel</th>
<th>wallOcclusion</th>
</tr>
</thead>
</table>

**float AkRoom::wallOcclusion = 1**

Occlusion level modeling transmission through walls.
In cases where a game object is in an area with two rooms, the higher priority room will be chosen for `AK::SpatialAudio::SetGameObjectInRoom()` The higher the priority number, the higher the priority of a room.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClosePortal</td>
<td>(GameObject in_gameObject)</td>
</tr>
<tr>
<td>GetID()</td>
<td></td>
</tr>
<tr>
<td>HandleEvent</td>
<td>(GameObject in_gameObject)</td>
</tr>
<tr>
<td>MAX_ROOMS_PER_PORTAL</td>
<td></td>
</tr>
<tr>
<td>rooms</td>
<td></td>
</tr>
</tbody>
</table>

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
## AkRoomPortal

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClosePortal</td>
<td></td>
</tr>
<tr>
<td>GetID</td>
<td>Access the portal's ID.</td>
</tr>
<tr>
<td>HandleEvent</td>
<td></td>
</tr>
<tr>
<td>MAX_ROOMS_PER_PORTAL</td>
<td></td>
</tr>
<tr>
<td>rooms</td>
<td></td>
</tr>
</tbody>
</table>

### `ulong AkRoomPortal::GetID()` [inline]

Access the portal's ID.
AkRoomPortal

<table>
<thead>
<tr>
<th>ClosePortal</th>
<th>GetID</th>
<th>HandleEvent</th>
<th>MAX_ROOMS_PER_PORTAL</th>
<th>rooms</th>
</tr>
</thead>
</table>

override void AkRoomPortal::HandleEvent

Opens the portal on trigger event.
AkRoomPortal

| ClosePortal |
| GetID       |
| HandleEvent |
| MAX_ROOMS_PER_PORTAL |
| rooms       |

void AkRoomPortal::ClosePortal(GameObject)

Closes the portal on trigger event.
### AkRoomPortal

<table>
<thead>
<tr>
<th>ClosePortal</th>
<th>GetID</th>
<th>HandleEvent</th>
<th>MAX_ROOMS_PER_PORTAL</th>
</tr>
</thead>
</table>

**MAX_ROOMS_PER_PORTAL**  rooms

**const int AkRoomPortal::MAX_ROOMS_PER_PORTAL**

AkRoomPortals can only connect a maximum of 2 rooms.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by [doxygen](http://www.doxygen.org) 1.6.3
<table>
<thead>
<tr>
<th>AkRoomPortal</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClosePortal</td>
</tr>
<tr>
<td>GetID</td>
</tr>
<tr>
<td>HandleEvent</td>
</tr>
<tr>
<td>MAX_ROOMS_PER_PORTAL</td>
</tr>
<tr>
<td>rooms</td>
</tr>
</tbody>
</table>

AkRoom [] AkRoomPortal::rooms:

The front and back rooms connected by the portal. The first room is on the negative side of the portal (opposite to the direction of the local Z axis). The second room is on the positive side of the portal.
AkRoomPortalObstruction

AkRoomPortalObstruction

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reflectAuxBus</td>
<td>AkSpatialAudioEmitter</td>
</tr>
<tr>
<td>reflectionMaxPathLength</td>
<td>AkSpatialAudioEmitter</td>
</tr>
<tr>
<td>reflectionsAuxBusGain</td>
<td>AkSpatialAudioEmitter</td>
</tr>
<tr>
<td>reflectionsOrder</td>
<td>AkSpatialAudioEmitter</td>
</tr>
<tr>
<td>roomReverbAuxBusGain</td>
<td>AkSpatialAudioEmitter</td>
</tr>
</tbody>
</table>
AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

AK.Wwise.AuxBus AkSpatialAudioEmitter::reflectAuxBus

The Auxiliary Bus with a Reflect plug-in Effect applied.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by Doxygen 1.6.3
AkSpatialAudioEmitter

uint AkSpatialAudioEmitter::reflectionsOrder

The maximum number of reflections that will be processed for a sound path before it reaches the listener. Reflection processing grows exponentially with the order of reflections, so this number should be kept low. Valid range: 1-4.
AkSpatialAudioEmitter

**reflectAuxBus**

**reflectionMaxPathLength**

**reflectionsAuxBusGain**

**reflectionsOrder**

**roomReverbAuxBusGain**

**float AkSpatialAudioEmitter::reflectionsAuxBusGain**

The gain \([0, 1]\) applied to the reflect auxiliary bus.
AkSpatialAudioEmitter

**reflectAuxBus**

**reflectionMaxPathLength**

**reflectionsAuxBusGain**

**reflectionsOrder**

**roomReverbAuxBusGain**

**float AkSpatialAudioEmitter::reflectionMaxPathLength**

A heuristic to stop the computation of reflections. Should be no longer (and possibly shorter for less CPU usage) than the maximum attenuation of the sound emitter.
<table>
<thead>
<tr>
<th>reflectAuxBus</th>
<th>reflectionMaxPathLength</th>
</tr>
</thead>
<tbody>
<tr>
<td>reflectionsAuxBusGain</td>
<td>reflectionsOrder</td>
</tr>
<tr>
<td>roomReverbAuxBusGain</td>
<td></td>
</tr>
</tbody>
</table>

**float AkSpatialAudioEmitter::roomReverbAuxBusGain**

Send gain (0.f-1.f) that is applied when sending to the aux bus associated with the room that the emitter is in.
AkState

AkState
groupID AkState
valueID AkState

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
int AkState::groupId

State Group ID, as defined in WwiseID.cs.
int AkState::valueID

State Value ID, as defined in WwiseID.cs.
<table>
<thead>
<tr>
<th>AkSurfaceReflector</th>
<th>AkSurfaceReflector</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AcousticTexture</strong></td>
<td><strong>AkSurfaceReflector</strong></td>
</tr>
<tr>
<td><strong>AddGeometrySet</strong> (AK.Wwise.AcousticTexture acousticTexture, MeshFilter meshFilter)</td>
<td><strong>AkSurfaceReflector</strong> [inline, static]</td>
</tr>
<tr>
<td><strong>RemoveGeometrySet</strong> (MeshFilter meshFilter)</td>
<td><strong>AkSurfaceReflector</strong> [inline, static]</td>
</tr>
</tbody>
</table>
static void AkSurfaceReflector::AddGeometrySet

Sends the mesh filter's triangles and their acoustic texture to Spatial Audio.

\[
\begin{align*}
\text{acousticTexture} & \\
\text{meshFilter} & 
\end{align*}
\]
static void AkSurfaceReflector::RemoveGeometrySet

Remove the corresponding mesh filter's geometry :

meshFilter
All triangles of the component's mesh will be applied with this texture. The texture will change the filter parameters of sound reflected from this component.
AkSwitch

AkSwitch
groupID AkSwitch
valueID AkSwitch

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
Switch Group ID, as defined in WwiseID.cs.

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
<table>
<thead>
<tr>
<th>groupID</th>
<th>valueID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**int AkSwitch::valueID**

Switch Value ID, as defined in WwiseID.cs.
AkTriggerBase

**AkTriggerBase**

**Trigger**(GameObject in_gameObject) **AkTriggerBase**

**triggerDelegate** **AkTriggerBase**

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by **doxygen** 1.6.3
delegate void AkTriggerBase::Trigger ( GameObject in_gameObject )

Delegate declaration for all Wwise Triggers.

in_gameObject is used to pass

in_gameObject when Colliders are used. Some
option "Use other object", this i

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by doxygen 1.6.3
AkTriggerBase

Trigger AkTriggerBase::triggerDelegate = null

All components reacting to the trigger will be registered in this delegate.
- AddGeometrySet(): \texttt{AkSurfaceReflector}
- AddListener(): \texttt{AkGameObj}
- ClosePortal(): \texttt{AkRoomPortal}
- ExecuteAction(): \texttt{AK::Wwise::Event}
- GetAuxSendValueForPosition(): \texttt{AkEnvironmentPortal}
- GetForward(): \texttt{AkGameObj}
- GetID(): \texttt{AkRoomPortal}, \texttt{AkRoom}
- GetPosition(): \texttt{AkGameObj}
- GetUpward(): \texttt{AkGameObj}
- HandleEvent(): \texttt{AkBank}, \texttt{AkRoomPortal}
- LoadLocalizedBank(): \texttt{AkMemBankLoader}
- LoadNonLocalizedBank(): \texttt{AkMemBankLoader}
- Post(): \texttt{AK::Wwise::Event}
- PostCallbacks(): \texttt{AkCallbackManager}
- PostMIDI(): \texttt{AK::Wwise::Event}
- RemoveGeometrySet(): \texttt{AkSurfaceReflector}
- RemoveListener(): \texttt{AkGameObj}
- SetBGMCallback(): \texttt{AkCallbackManager}
- SetMonitoringCallback(): \texttt{AkCallbackManager}
- StopMIDI(): \texttt{AK::Wwise::Event}
- Trigger(): \texttt{AkTriggerBase}
- UnloadBank(): \texttt{AkBank}
- **a** -
  
  - AcousticTexture : **AkSurfaceReflector**
  - actionOnEventType : **AkEvent**
  - axis : **AkEnvironmentPortal**

- **b** -
  
  - bankName : **AkBank**, **AkMemBankLoader**
  - basePath : **AkInitializer**

- **c** -
  
  - callbackManagerBufferSize : **AkInitializer**
  - curveInterpolation : **AkEvent**

- **d** -
  
  - decodeBank : **AkBank**
  - defaultPoolSize : **AkInitializer**
  - diffractionFlags : **AkInitializer**

- **e** -
  
  - enableActionOnEvent : **AkEvent**
  - engineLogging : **AkInitializer**
  - eventID : **AkEvent**

- **g** -
- g -
  groupID : AkState, AkSwitch

- i -
  info : AkEventCallbackMsg
  isEnvironmentAware : AkGameObj
  isLocalizedBank : AkMemBankLoader

- l -
  language : AkInitializer
  loadAsynchronous : AkBank
  lowerPoolSize : AkInitializer

- m -
  m_positionOffsetData : AkGameObj
  MAX_ROOMS_PER_PORTAL : AkRoomPortal
  maxSoundPropagationDepth : AkInitializer
  memoryCutoffThreshold : AkInitializer
  monitorPoolSize : AkInitializer
  monitorQueuePoolSize : AkInitializer

- p -
  preparePoolSize : AkInitializer
  priority : AkRoom

- r -
  reflectAuxBus : AkSpatialAudioEmitter
  reflectionMaxPathLength : AkSpatialAudioEmitter
  reflectionsAuxBusGain : AkSpatialAudioEmitter
  reflectionsOrder : AkSpatialAudioEmitter
  reverbAuxBus : AkRoom
  reverbLevel : AkRoom
  roomReverbAuxBusGain : AkSpatialAudioEmitter
  rooms : AkRoomPortal
- s -

- saveDecodedBank : AkBank
- sender : AkEventCallbackMsg
- soundEmitterObject : AkEvent
- spatialAudioPoolSize : AkInitializer
- streamingPoolSize : AkInitializer

- t -

- transitionDuration : AkEvent
- triggerDelegate : AkTriggerBase

- u -

- unloadTriggerList : AkBank

- v -

- valueID : AkState, AkSwitch

- w -

- wallOcclusion : AkRoom